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WORD PROCESSORS 
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Definition of a word processor 

 

What is a word processor? 

A word processor is an application software that enables a person to create, save, edit, 

format and print text documents. Word processing is the act of using a word processor.  

 

Examples of word processors 

Examples of word processors include, Microsoft Word, Corel WordPerfect, WordStar, 

Lotus WordPro and many others. 

A word processor has a number of advantages over he type writer that include: 

1. A document can be stored in the computer for future reference in computer files 

that do not occupy physical space like the one on paper. This creates a paperless 

document-processing environment. 

2. Typing using a word processor is easier and more efficient because some actions 

are automated. For example, word-wrap feature automatically takes the cursor to 

the beginning of the next line once you reach the end of the current. Another 

automatic features common in most word processors is automatic insertion of a 

new page after reaching the end of the current page. 

3.  Most word processors have special editing tools such as spelling  and grammar 

checkers and thesaurus that help the user to easily Correct grammar and spelling 

mistakes. A thesaurus helps to find a word or phrase with similar meanings. 

4.  With insert and type over modes available in most word processors, one can 

easily insert or replace a word or a phrase without affecting the structure and 

neatness of the document. 

5. Word processors have superior document formatting features. Formatting refers to 

the art of making the document more attractive and appealing to the eye. Such 

features include, underlining, boldfacing, italicization, applying different colors 

etc. 

6.  While a typewriter may require that we retype the entire document when we want 
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many copies, with a word processor, printing lets you produce as many copies per 

session as needed. 

7. Using the cut, copy and paste commands, you can incorporate other text without 

having to retype it. 

 

Basic word processing features and concepts  

1. They allow the user to create a file, save it and open it again and again for reuse, 

editing or formatting. 

2. They have almost similar document windows with the following Features: 

(a) Most are designed to look like a piece of paper with a few  

(b) Most of the screen is blank before typing of text. 

(c) There is a cursor, which blinks at the position where you can Begin entering text. 

(d) There is a status bar or line that provides the user with current status information such 

as saving operation, the name of the file in use, the current page, the current imaginary 

horizontal-line and column cursor position. 

(e) Word wrap: The feature that automatically moves a word or cursor to the beginning 

of the next line if it does not fit at the end of the current line. 

(g) Scrolling: This is the vertical movement of text document on the screen. We can 

scroll through a text document using the up or do n arrow keys, page up and page down 

keys and also using, a mouse in windows based word processors. 

(h) Help: Sometimes we get lost, confused or need more information on how to use an 

application. Help contains instruction, tips, pointers, explanations and guidance. You can 

get help by either pressing F 1 on the keyboard or clicking Help from the menu. 

(i) Editing Modes: Word processors have two editing modes, insert and type over mode. 

In insert mode, every character typed between words, lines or characters is placed at the 

cursor position. This pushes all the text in front of the cursor away without deleting it. 

However in type over mode every character typed deletes what was there before and 

replaces it with new text at the cursor position. 

3. Nearly all word processors have a spelling checker, thesaurus (Dictionary of 

synonyms) and grammar checker. 

4. They provide for the use of headers and footers, indexing, footnotes and references, 

typefaces (fonts) and character set. 

5. Most word processors have ability to create and import tables, text and graphics from 

other programs. 

Mostly, word processors are used for writing letters, reports, projects, books, essays, 

memos curriculum vitae etc. 

Factors to consider when choosing a word processor The choice of a word processor 

depend on: 

1. The type of operating system. For example, most microcomputers are currently 

running on Windows based operating system such as Microsoft Windows. This means 
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that you should consider acquiring a graphical user interface based Word Processor, 

2. Its user-friendliness, i.e. ease of use. 

3. Its formatting and editing features. They should be good and varied. 

 

Using a word processing package Microsoft Word 

. 

Microsoft Word is one of the components of Microsoft Office. Microsoft Office is 

integrated software with a number of interrelated programs. The programs include 

Microsoft Word, a spreadsheet called Microsoft Excel, and a database management 

system called Microsoft Access, communication software called Microsoft Outlook, and a 

presentation package called Microsoft PowerPoint among others. 

Although there are several versions of Microsoft Word, the most common are Word 97, 

Word 2000, WordXP and Word 2003. These versions of Microsoft Word are found in 

Microsoft Office 97, 2000, XP and 2003 suites respectively.  

Starting Microsoft Word 

There are a number of ways you can start Microsoft Word. However the 

Simplest is by using programs start menu. 

 

Starting Microsoft Word from the start menu 

1. Click the start button. 

2. Point to programs/ all programs if you are using Windows XP 

3. Click from the programs menu  

Microsoft Word screen layout 

Once you start Microsoft Word, it provides you with a blank document window referred 

to as the new document template where you can create your document.  

However you may need to use other specialised templates such as Faxes and letters, 

Memos and Web page. How? Click File then select New from the menu. The New dialog 

box in Figure 1.3 that appears enables a person to select a template by activating 

templates tab then double clicking its icon. 

 

With Windows multitasking capability, you can have more than one document window at 

the same time sharing one application window. However, each document window will 

have its own title bar but both will share other facilities like the menu bar of the 

application window. 

However only one document window will be visible on the desktop at a time while others 

remains minimized or covered. This window is referred to as the active document 

window. To switch between document windows, click their buttons on the taskbar. 

 

Parts of a window 

 

Title bar 

A title bar is mostly a blue strip at the top of the window that displays the title of the 

currently running application or task. However it is possible to change the color of the 
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title bar using the display properties. 

 

The title bar also enables the user to move the window around the desktop. This is 

possible by pointing to it then dragging using the mouse. 

 

On the right of the title bar are three tiny buttons called minimize, restore/ maximize and 

the close buttons. 

The minimize button reduces a window to become a button on the taskbar. 

 

The restore/maximize button stretches the window to cover the entire desktop or restore it 

to its original size respectively. 

The close button is used to close and exit a window. 

 

Menu bar 

Provides a drop down list of commands that one can use to perform a task. Examples are 

File, Exit, Window and Help. Figure 1.4 shows the File drop down menu. 

Too/bars 

These are rows of buttons or icons that represent commands. The command buttons are 

shortcuts to the same commands you can access from the menu bar. There are various 

toolbars available in Microsoft Word but the most common are the Standard and 

Formatting toolbars (Figure 1.5 and 1.6) 

To see what other commands are, just point to the icon on the toolbar and a text tip will 

be displayed showing the function of the icon. 

Most of these commands will be discussed later. 

Hiding and displaying the toolbars 

1. Click the View menu option. 

2. Position the pointer on Toolbars. 

3. Click the type of tool bar required to select it. 

 

Selected toolbars have ticks or check marks next to them as shown in Figure 1.7. 

Rulers 

Microsoft Word provides the user with vertical and horizontal on screen rulers that helps 

the user position text or objects in the right position. 

 

If the ruler is not visible on the screen, then display it using the following procedure. 

1. Click the View menu option. 

2. On the drop down menu that appears, click Ruler. A check mark or tick will appear 

next to it showing that the ruler is displayed on the screen. 

 

Work area 
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This is the working area where you can enter text or graphical objects. All windows 

based application programs provide the user with a unique working area suited to that 

particular application. 

 

Status bar 

This is an interactive strip at the bottom of the screen that acts as a communication link 

between the user and the program. It displays interactive activities like saving, opening, 

background printing, cursor position etc.  

Scroll bars/button_ and scroll arrows 

Scroll bars or buttons are horizontal and vertical bars on the borders of a window that the 

user drags to scroll upward, downwards, to the right or left of a document. Scroll arrows 

are arrows at the end of the scroll bars that the user clicks instead of dragging the scroll 

button. Using scroll bars or arrows is equivalent to using the arrow keys on the keyboard 

 

Running the program 

 

Creating a document 

When you start a new document, you will see a blinking vertical bar called an insertion 

pointer. You can move your insertion pointer by using the arrow keys or the mouse. 

 

In case you are in Microsoft Word and you want to create another new document, you 

should proceed as follows: 

1. Click the File menu, 

2. Choose new, from the resulting dialog box, click Blank Document Or select template 

by clicking any template's tab 

3. Click the OK button. 

 

Saving a new document 

1. From the file menu, click save or Save As or simply click the save Button on the 

Standard toolbar. The difference between save and save as is that although both give the 

save as dialog box when saving for the first time, Save allows the user to save document 

without the opportunity to change the file name or the location. Figure 1.9 below shows a 

save as dialog box. 

2.In the file name box, type a unique name for the document 

3.Select a the location or drive you want to save in, by clicking the down arrow on the 

right of save in list box, 

4.To save the file in a different format or type such as Word 6.0, Word for Macintosh etc. 

click the down arrow on the right of Save as type list box and choose a file type. 

5.Click the save button. The file will automatically be saved as a Microsoft Word 

document. 

Opening an existing document 
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1.From the file menu, click Open command or on the Standard toolbar, click the Open 

button. Alternatively press Ctrl + 0 key combination on the keyboard. The Open dialog 

box shown appears. 

2.Select a drive or folder where the file is saved. 

3.In the file name box, type or select the name of the document you want to open. 

4.Click the open button 

To open a document created in another program, click the file format you want in the 

files of type box, and then double click the document name in the folder list. You can 

also use wildcards in the file name box for example, type *. Document to find Microsoft 

Word files. 

 

NB: Microsoft Word keeps a list of shortcut links to recently used files on the file drop 

down menu. If the list of recently used documents is not displayed, you can configure 

Microsoft Word to be displaying them by doing the following: 

1. Click the Tools then Options command. This displays the options Dialog box. 

2. On the general tab, select the recently used file list check box as Shown in Figure 1.11. 

 

Protecting a document with a password 

A password is a combination of characters that prevents other users from opening and 

changing a document without permission. If a document is protected by a password, only 

the person who knows the password can open the document or edit it. 

 

To save a document with a password 

1. Create or open the document you want to protect 

2. From the file menu, choose Save As. 

3. Click the down arrow on the Tools button in the save as dialog box  

4. Click General options. 

5. Type in a password in the password to open. This prompts the user to enter password 

when opening a document. 

6. Type in a password in the password to modify. This prevents the user from making 

changes to a document unless the user enters the correct password. 

7. Finally click OK. 

 

Closing a document 

Closing a document means unloading the current active document from memory so that 

the user can create or open another without necessarily exiting from Word. 

To close a document: 

1. Click the File menu.  

2. Choose Close. 
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Exiting from Word 

1. To exit from Word, make sure all open documents are saved.  

2. Click File menu, 

3. Click Exit command. 

 

NB: You can exit from Microsoft Word by pressing Alt + F4 keys or by double clicking 

the application icon at the left most comer of the title bar. If you have not saved any of 

the open documents, Microsoft Word prompts you to save the document first. 

 

1.4 

Editing and formatting a document 

 

Editing 

Editing refers to making necessary changes to an existing document. Apart from manual 

editing using delete, insert and overtype/overwrite commands, Microsoft Word provides 

the user with inbuilt tools such as the spelling and grammar checker, thesaurus, undo and 

re-do, find and replace etc. 

 

Block operations 

 

Selecting (highlighting) a block of text 

The purpose of selecting text is to enable the user perform a number of editing or 

formatting operations on the selected block of text. Microsoft Word presents the user 

with a number of ways for selecting a block of text. You can either select a block of text 

using the mouse or keyboard. 

 

 Selecting with a mouse 

  1. To select a word, place the insertion pointer on the word then, double Click it. 

 2. To select a sentence, positions the mouse pointer at the left margin until it changes to 

a right arrow, and then click once.   

  3. To select a paragraph, place the pointer at the beginning or end of the paragraph. 

Notice that the pointer changes to I-beam. Now drag the I-beam over the text to be 

selected and release the mouse button at the end of the text you wish to work on. 

 

Selecting with the keyboard  

1. To select one word, move the insertion pointer to the beginning or End of the 

word then press Shift+Ctrl+Right or left arrow. 

2. To select one line, press Shift+Up or Shift+Down arrow key. Alternatively, move 

the insertion point to the end or beginning of The line then press Shift+Home or end 

keys respectively.  

3.To select an entire page; press Shift+Page Down or Shift+Page Up. 4. To select the 

entire document, press Ctrl+A or place the cursor at the beginning of the document 
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then press Shift+Ctrl+End. 

 

Deleting text 

1. To delete a character or a word from the right to the left, place the insertion pointer on 

the right of the word then press the backspace key. 

2. To delete a character to the right of the cursor position, place the Insertion pointer on 

the left of the word then press the Delete key. 

 

To delete a block of text 

1. Highlight the text to be deleted.  

2. Press the Delete key. 

 

Restoring deleted text 

To restore text that has just been deleted in the current word processing session: click the 

Edit menu, then the Undo command 

 

Copying and moving text and objects 

Copying means creating a duplicate of text or an object while moving means changing 

the position of text or an object in a document. In Microsoft Word, you can copy or move 

a block of text. 

To copy a block of text: 

1. Highlight the text, 

2. Click Edit, then Copy or simply click the Copy button on the standard Toolbar. 

3. Position the insertion pointer where you want to copy the text, 

4. Click Edit then Paste or simply click the Paste button on the standard toolbar. 

 

NB: To use the keyboard shortcut keys, press Ctrl + C to copy, then Ctrl + V to paste 

 

To move text and objects  

1. Highlight the text, 

2. Click Edit, then Cut or simply click the Cut button (whose icon is a Pair of scissors) 

from the standard toolbar. 

3. Position the insertion pointer where you want the text to be placed,  

4. Click Edit then Paste or click the Paste button on the standard toolbar. 

 

NB: To use the keyboard shortcut keys, press Ctrl + X to cut, then Ctrl + V to paste 

Typing modes 

There are two typing modes in a word processor that assist the user in typing or editing 

text documents. These are: 
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1. Insert mode.  

2. Overtype/typeover mode. 

 

Insert mode 

This is the default mode in most word processors. In this case when text is inserted 

between words or characters it pushes the existing text away without replacing it. 

 

Typeover mode. 

In this case, when text is typed between existing words or characters, the new text 

automatically replaces the existing text by deleting it. To switch between typeover and 

insert mode, simply press the insert key on the keyboard or double click the OVR label 

on the status bar. 

 

Find and replace 

When you need to search for a word or phrase in a large document, use the Find 

command. In case you wish to replace a word or phrase, use the Replace option. 

 

Find 

1. Click Edit menu, then click Find command. The find dialog box appears. 

2.  Type the text or phrase you want to search for then click FindNext 

3.  Step 2 can be repeated if you wish to find other occurrences of the same word or 

phrase. Click OK when a message appears telling you that Microsoft Word has 

finished searching the document. Click Cancel to close the dialog box. 

 

NB: You can use the keyboard shortcut Ctrl+F to find. Some search options: 

 

You can specify search options by clicking the more buttons to display them. They 

include: 

1. Match case: This identifies only text that matches in case with that in the find 

what box e.g. it will not find the word DEEN if you typed deen and selected the 

match case option. 

2. Whole Word: Searches for a word or phrase that is whole. If it is part of another 

word it will not be found, e.g. the word ever will not be found in words like 

however, whenever etc. during the search. 

3. Use wildcards: Wildcards are special symbols such as * and? That are used to 

represent a set of words with certain characters in common e.g. names like Jeff, 

Joe, Jane can be represented using a wildcard as J* which means all names 

starting with J. 

4. Like: Searches for words, which are similar in pronunciation e.g.,  fare and fair. 

 

Replace command 
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Click Edit menu then Replace command. The dialog box appears. 

 

Type the name you want to replace in the Find what box and the one that will replace it in 

the Replace with box. Click the Find next button to find the next occurrence of the word 

then click Replace button to replace it. To replace all the occurrences of the word in the 

document at once, click the Replace all button. 

Proofreading 

Proofreading refers to checking whether the document has typographical or grammar 

errors. Microsoft Word has tools for proofreading e.g. spelling and grammar checker, 

Thesaurus, Autocomplete and Autocorrect. 

 

Spelling and grammar checker 

The spelling and grammar checker is an inbuilt tool that helps the user to correct spelling 

errors and incorrect grammar structures. However, the checker can only recognise errors 

of those words whose correct spelling is in its dictionaries. A correctly spelt word used 

wrongly cannot be detected hence the document should be proofread just before and after 

printing. To check the accuracy of spelling and grammar: 

1. Click Tools menu option. 

2. Click Spelling and grammar on the drop down menu. The spelling 

And grammar checker dialog box appears as shown in Figure 1.14. 

Words that do not match in the custom dictionary are highlighted for correction. The 

lower plane of the dialog box suggests to the user with a list of suggested correct words. 

3. Either choose one of the following buttons: 

(a) Change to correct only the highlighted incorrect word. 

(b) Change all to correct all the occurrences of the misspelled word. 

(c) Ignore to retain the highlighted and continue. For example, although a word like 

jembe may not be in the custom dictionary, in the Kenyan context, the word is acceptable 

therefore if highlighted, click Ignore. 

(d) Ignore all to retain all the occurrences of the same word or phrase in the document 

from another language e.g. a Kiswahili 

(e) Click Add to add the word into the custom dictionary. 

 

In case you want to undo the changes made, click on the Undo button at the lower bottom 

of the spelling and grammar dialog box. 

 

NB: You can close the spelling and grammar dialog box even if the process is not 

complete by choosing Close. 

 

Using the thesaurus 

This is an editing tool that helps the user find words or phrases with similar meaning 

(synonyms) or opposite meaning (antonyms) to the one selected. 
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To use the Thesaurus: 

 

1. Select a word or a phrase. 

2. Click Tools, and then point to Language. 

3. Click Thesaurus to see Figure 1.15 displayed on the screen. 

4. For synonyms, under the heading Replace with Synonym, choose an alternative word 

phrase you intend to use as replacement for the selected text. 

5. To replace a word or a phrase with an antonym, select the word or phrase with 

antonym enclosed in brackets. 

6. Click Replace. 

 

Autocomplete The auto complete feature displays a complete word when the user types 

the first few characters of the word. This enables the user to type faster by simply 

accepting the suggested word if indeed he/she intend to type it. To accept the suggestion, 

simply press the Enter key, and continue typing other word or phrases 

The figure shows an auto text that automatically completes Dear sir or Madam text 

entries. 

 

To turn auto complete on/off 

1. Click Insert menu and point to Auto text. A dropdown list is displayed. 

2. Click AutoText. 

3. Select or clear the Show AutoComplete tip for AutoText and dates Check box  

4. Type in an Auto text in the Enter AutoText entries here text box then Click Add. 

 5. Click Close. 

Autocorrect 

The auto correct feature automatically detects wrongly spelled or capitalised words and 

replaces them with the correct word. However, the settings of auto correct are user 

defined e.g. if a person keeps on typing the word certain as certain, set the auto correct 

feature to replace the later with the former. Figure 1.18 shows the auto correct feature. 

 

To turn auto correct on/off 

1. Click Tools menu, then AutoCorrect. 

2. To turn on the spelling checker corrections, select the Replace text as you type check 

box, and then select the Automatically use suggestions from the spelling checker check 

box. 

3. To turn off the spelling checker corrections, click Automatically use suggestions from 

the spelling checker check Box at the bottom of the dialog box  

4. Click OK to close the dialog box.  

Undo and redo 
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Undo: It reverses the last command that was issued in Order to revert back to the 

previous state. To undo, click Edit then Undo command. 

Redo: It does the last undone action. To redo, click Edit, then Redo Command. 

 

Formatting a document 

Formatting refers to applying various styles or features to enhance the document's 

appearance. You can format text, a paragraph or a page. 

Text formatting 

Text formatting refers to features such as changing fonts (type, style and size of 

characters), changing text color, underlining, bolding Italicising etc. You can use either 

the formatting tools bar or the Format menu to underline, bold, etc. 

 

To format existing text using the format menu 

1. Highlight the text to be formatted 

2. From Format menu, click the Font command. A dialog box with all Text formatting 

features is displayed  

3. To change font type and size, where necessary scroll down the Font list box then click 

the font required, for example Verdana font style would appears as Verdana. To increase 

the font size, where necessary, scroll down the Size list box and select the required size 

e.g. 12 points (pt). A point is 1/72 of an inch in height. 72 points i.e. 72/72 is equivalent 

to 1 inch For example "Verdana" is in Times New Roman 16 points and "Verdana" is in 

Verdana 16 points. 

4. Bolding text: Bolding makes the selected text appear darker than the rest of the text. To 

bold text: 

(a) Activate the font dialog box.  

(b) From the font dialog box, select Bold. 

5. Underline text: Underlining refers to placing a line at the base or bottom of a word or a 

phrase. To underline: 

(a) Activate the font dialog box. 

(b) Click the down arrow at the right of Underline style and select. The underline style 

required e.g. single, double, dashed etc. 

6. Italicising text: To italicise is to make the text slant forward.  

(a) To italicise activate the font dialog box. 

(b) Click Italic. 

7. Changing the font color: In most cases, the font default color is black. However you 

can change the font color for example to red, green, blue etc. To change the font color, 

(a) Activate the font dialog box 



 13 

(b) Click the down arrow at the right of font color list box and 

Select the color of your choice. 

 

Using formatting toolbar 

As mentioned earlier, the formatting toolbar lets the user easily format text by clicking 

the required format button. To format some text, highlight it first then click a command 

on the toolbar.  

For example to bold text, highlight it then click then bolding command (B) on the 

formatting toolbar. 

 

Paragraph formatting 

 

Text alignment 

Text alignment refers to how text is lined up on the page relative to the left, right or 

center of the page. There are four ways in which text can be aligned namely left aligned, 

centered, right aligned and justified. 

 

Left alignment 

Lines of text are lined up evenly along the left margin but unevenly at The right margin. 

This is the default alignment. To align left, 

1. Highlight your text. 

2. Simply click the left alignment button. Alternatively click format, Paragraph. And 

select left from the alignment list box as shown in Figure 1.20. 

3. Click OK. To apply the choice. 

 

Right alignment 

This is opposite of left alignment. Lines of text are lined up evenly along the right margin 

but unevenly at the left margin. To align right, 

1. Highlight your text 

2. Simply click the right alignment button. Alternatively click Format, Paragraph. select 

Rigl1t from alignment list box, then click OK.. 

Center alignment 

The lines of text are centered unevenly between the left and right margins. 

To center text, 

 

1. Highlight your text, 

2. Simply click the Center, button. Alternatively click format, paragraph, 

 Select centered from alignment list box, then click OK. 

Justification 

Lines of text are arranged evenly along the left and right margin. 
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To justify text, 

1. Highlight your text 

2. Simply click the Justify alignment button. Alternatively click Format, 

Paragraph, select Justify from Alignment list box, then click OK. 

 

Change case 

When typing a text, there are a number of cases the user may intend to apply in order to 

create contrast within the text. These are: 

1. Sentence case: All the first characters in a sentence are in uppercase (Capitalised). 

2. Lowercase: All characters appear in lowercase. 

3. Uppercase: All characters appear in uppercase. 

4. Title case: All the first characters of each word in a sentence appear in uppercase. 

5. Toggle case: It changes upper cases to lowercases and vice versa. 

 

Figure 1.21 shows a dialog box for change case. 

 

To change case in an existing text; 

1. Highlight the text. 

2. From the format menu, click Change case. 

3. From change case dialog box, select the case type to be applied.  

4. Click OK. 

Drop caps 

There are times when you wish to attract the reader's attention by making the first 

character in a sentence large, taking more space in the next line. Such kind of a character 

is said to be "dropped". 

To apply drop cap; 

1. Highlight the first character in the sentence 

2. From the Format menu, click Drop Cap. Drop cap dialog box appears 

3. Click Dropped or In Margin 

4. Select font in case you wish to apply a certain font to the dropped Cap 

5. Specify the number of lines to drop. 

6. Click OK 

Indenting paragraphs 

Indentation refers to moving the text away from the margin. You can indent the first 

sentence in a paragraph (first line), the whole paragraph (full indent) or the rest of the text 

except the first line (hanging indentations). 

First line indent 

1. Select the paragraph to be indented 

2. From the format menu click paragraph. Paragraph properties dialog box appears 
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3. Click the down arrow in the list box under Special and select First Line. 

4. Specify by how far the paragraph is to be indented from the margin 

In the by text box  

Click OK to apply the indent and close the dialog box. The paragraph will be 

indented  

NB: You can also indent the first line by positioning the cursor at the beginning of the 

paragraph then press the Tab key. 

Hanging Indent 

1. Select the paragraph to be indented 

2. From format menu, click Paragraph. 

3. Click the down arrow in the list box under Special and select Hanging. 4. Specify by 

how far the paragraph is to be indented from the margin In the by text box 

5. Click OK to apply the indent and close the dialog box. The paragraph will be indented  

Full indent  

1. Select the paragraph to be indented or position the cursor anywhere in the paragraph 

2. From the formatting tool bars, click the Increase or Decrease indent Button 

Setting tabs 

Tabs are used to indent the first line of a paragraph or create columnar data. By default 

the tab stop is set at 0.5 of an inch. To change the default setting: 

1. From the format menu, click Tabs 

2. Enter a new value for tab stop in the Tab stop Position box.  

3. Choose the type of tab either left, center or right. 

4. If need be specify the Tab leader option 

5. Click the Set button then OK. 

Setting tabs using the ruler 

The easiest way to set tabs is by using the ruler. On the left comer of the horizontal ruler 

is a tab alignment button that lets the user select the type of tab. Figure 1.28 shows 

various tab alignment buttons, while Table 1.1 gives an explanation of each button. 

To set the tab using the ruler; 

1. Click on the tab button to choose the required tab type. Notice that the tab type keeps 

on changing as you click the tab button. 

2. Set the tab stop by clicking where you want it to be on the ruler.  

3. Drag the tab stop 

 

Button Name Purpose 

 Left tab Text is left aligned 

 Center tab Text is centered 

 Bar tab Inserts a vertical line at 

  Tab stop and align text to 

  The right of the line 

. Decimal tab Text is aligned at decimal 

 Character 
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 Right tab Text is right aligned 

 

Table 1.1 Examples of tabs 

 

Line and character spacing 

Line spacing refers to the vertical distance between lines of text. The default line spacing 

is single spacing. This type of spacing accommodates the characters in a text leaving a 

small extra space between lines. Character spacing on the other hand refers to the space 

between the characters in the text. 

 

To change line spacing:  

1. Highlight the text, 

2. From format menu, click Paragraph to display the paragraph dialog Box. 

3. Click the down arrow from the Line Spacing list box and select the Type of spacing 

required e.g. double, 1.5, at least etc.  

4. Click OK to effect the changes. To change character spacing: 

1. Highlight the text 

2. From Format menu, click Font.  

3. Click the Character Spacing tab  

4. Adjust the spacing as required  

5. Click OK.  

Bullets and numbering 

Bullets and numbers are used to mark steps in a procedure or items in a list. 

To apply bullets and numbers in a list:  

1. Select the list. 

2. From the Format menu, click Bullets and numbering. A dialog box appears. 

3. Do one of the following; 

(a) To apply bullets, click the Bulleted tab. 

(b) To apply independent numbers click the Numbered tab. 

(c) To apply outlined numbered list, click Outline Numbered. Tab  

4. Click OK to effect the changes and close the dialog box. 

  

Section breaks 

A break is used to identify where a section, a column or a page ends and the beginning of 

next. This allows the user to apply more than one paragraph or page format in the same 

document especially when it comes to page layout, size, different margins etc. 

 

To insert a section break  

1. Position the text cursor in the document where the break is to be inserted.  

2. Click Insert then. Break.  

3. From the Break dialog box select the type of section break to insert e.g. page break. 

4. Click OK. 

  

Formatting pages 

 Inserting page breaks 

A page break identifies the end of one page and the beginning of the next. NofQ1ally, 
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Word automatically inserts a new page after the current. One is full. However, there may 

be a need to start a new page even if the. Current one is not full. 

 

To insert page breaks: 

1. Position the pointer where the break is to be inserted.  

2. Click Insert then Break. 

3. From the Break dialog box  

4.  Click Page break then OK. 

 

Creating columns 

To, create columns on existing text: 

1. Highlight the text 

2. From Format menu, click Columns to display the dialog box 

3. In the columns dialog box, select the number of columns or type in  the Number of 

columns text box 

4. In the Width and spacing boxes, specify the column widths and space between 

columns  

5. Click OK 

Page setup 

Page setup options let the user specify the size of the margins, paper size, paper source 

and layout. 

 

Setting margins 

Margins are blank spaces around the edges of the page. Only text and objects inside the 

margins are printable. 

 

To set up margins: 

1. Click the File menu then Page setup. Page setup dialog box appears 

2. Click the Margins tab. 

3. Enter the values for the left, right, top and bottom margins in the respective boxes. 

4. Click OK. 

 

Setting the paper size 

By default, the paper size may be either Letter or A4. An A4 paper has dimensions 210 

mm x 297 mm 

 

To specify a different paper size 

1. From the File menu click Page setup  

2. In the page setup dialog box click the Paper size tab. 

3. Select the size of paper required from the paper size list. If your size is different from 

the ones provided, click Custom size and enter dimensions in the height and width boxes. 

4. Click OK. 

Specifying page orientation 

The term page orientation refers to the positioning of the page in relation to the text. The 

two available orientations are: 

Portrait: text and graphics are printed with the longest side vertically upright. For 
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example, on an A4 piece of paper, the 210 mm edges are at the bottom and top. 

 

Landscape: With landscape, text and graphical objects are placed with the longest side of 

the page placed horizontally and the lines of text printed parallel. For example, to create a 

timetable on an A4 page, the 297 mm side should be horizontal. 

 

To select the orientation: 

1. From File menu, choose Page setup. 

2. Click on the Paper size tab and a dialog box comes on the screen. 

3. Select the orientation required then clicks the OK button. 

 

Page layout 

This option lets the user specify how text will be placed on the page from the margins. By 

default, text starts from the top margin. 

 

To change the layout 

1. From File menu, choose Page setup. The dialog box Appears. 

2. Click on the Layout tab. 

3. From the Vertical alignment tab, select the alignment required then click OK. 

 

Inserting headers and footers 

Headers, footers and page numbers make it easy to locate information. Headers are few 

words placed at the top of every page while footers appear at the bottom. To insert 

headers and footers: 

1. Click on the. Headers and Footers from the View menu 

2. In the text boxes that appear, type a header using the top text box or a footer using the 

bottom text box or even both if you are to insert both a header and footer. 

Inserting page numbers 

To give your document page numbers: 

1. From the Insert menu, click Page numbers to display the dialog box 

2. In the Position box, specify where you want the page numbers to be inserted. 

3. In the alignment box, specify whether the number is to be on the right, left, center, 

inside or outside 

4. Use the Format button to choose the number format, i.e. 1,2,3,..., A,B, C  etc. You can 

start from any page number by using Start at box 

 

Creating and editing tables 

 

Creating tables 

A table is a feature in Microsoft Word made up of rows and columns that is used to 

organise and enhance display of information. 

 

Creating a new table 

 . . 

You can create a table either by using the Insert Table command from tables menu, or by 

using Draw Table tool that resembles a pencil to create more complex tables. 
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To create a table using the insert table command; 

1. Click Tables menu, position the pointer on Insert, then click Table 

2. In the Insert table dialog box displayed, specify the number of rows and columns. 

3. Click OK. The table will be displayed on the screen and you can start entering data in 

it.  

NB: You can insert a table by clicking the table button on the standard toolbar, then drag 

to select the number of rows and columns. 

 

To create a table using the drawing tool: 

1. Click Tables menu, then Draw table or simply click the Draw table button from the 

standard toolbar. The mouse pointer changes to a pencil symbol 

2. Drag the pointer to draw the outline of the table 

3. Fill in the table with rows and columns by dragging the pointer as you would draw 

using an ordinary pencil. 

 

Formatting and editing a table 

 

Inserting rows and columns 

To insert a row: 

1. Place the cursor where you want to insert a row 

2. Click Table, point Insert then click Row above or Row below. 

 

To insert a column: 

1. Place the cursor where you want to insert a column 

2. Click Table, point Insert then click Column to left then Column to the Right. 

 

Adjusting the column width: 

 1. Position the mouse pointer on the row or column boundary until the mouse pointer 

changes to an arrowed cross.  

2. Drag the boundary to the required size. 

 

Deleting rows, column or cells 

1. Select the rows or columns to be deleted. 

2. From Table menu, point Delete, then Columns, Rows or Cells. 

 

Merging cells in a table 

This refers to combining more than one cell in a table. To merge cells: 

1. Select cells to be merged 

2. From Tables, click Merge cells. 

 

Splitting cells in a table 

This refers to subdividing a cell or cells into more cells. To split cells: 

1. Select cells to be split 

2. From Tables, click Split cells. A dialog box appears that lets you specify the number of 
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rows and columns that the selected cells will be split. 

 

Formatting table borders and shading 

Word provides the user with automatic formatting feature that lets you choose border 

styles and shading. 

 

To format a table: 

1. From Table menu, click Table AutoFormat. 

2. In the formats list box, select the format you want. Note that the format you choose 

applies to borders, shading font and colour. 

3. Click Ok to apply the effects. 

NB: You can also format a table by using the table's toolbar. If the toolbar is not 

displayed, click view point to toolbars then click tables and Borders. 

 

 

Table conversions 

With convert feature in Microsoft Word, you can convert a table to lines of text and vice 

versa. 

 

To convert a table to text 

1. Select the entire table or row and columns you want to convert to text. 

2. From table menu, point to convert then click table to text. A dialog box is displayed 

that requires you to specify how the text will be separated after conversion  

3. In the separate text with box enter or select the character to be used as a separator. 

4. Click ok 

 

To convert text to table: 

1. Select the text that you want to convert to a table. 

2. From table menu, point convert then  click text to table .A dialog box is displayed that 

requires you to specify the number of rows and  of columns 

3. From Separate text at, specify whether the table will be defined by paragraphs, 

commas, Tabs or other characters. 

4. Click OK. . 

 

Importing tables 

Microsoft Word lets you import tables from other applications or an existing file. To 

import a table, 

1. Click the Insert menu then Objects. A dialog box appears 

2. From the Object type select the type of object to insert e.g. Adobe table. 

3. The program in which the table was created in starts and lets you choose a table from it 

and return back to Microsoft Word. Alternatively click Create from file. This lets you 

browse for a file that contains the table you wish to insert. 

4. Click OK to insert the table. 

 

Performing arithmetic calculations in a table 
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It is possible to perform mathematical calculations such as sum, product and count, if a 

table has numerical figures. 

 

To perform calculations: 

1. Click the cell in which you want the result to be placed. 

2. From the Table menu, click Formula. A formula dialog box is displayed. 

3. Type the formula you want or select from the Paste function box. For example, to add 

figures in a row or column, click SUM. The function in Table 1.2 below that calculates 

the total is =SUM(ABOVE). The word "ABOVE". in brackets is called the argument of 

the formula and tells Microsoft Word which cells in the table are to be worked on. 

Sorting 

In Microsoft Word you can sort a list of text, numbers and dates in ascending or 

descending order. 

To sort a list or table: 

 

1. Highlight the text list or table you want to sort.  

2. From the Table menu, click Son. 

3. Select the type of data to be used when sorting i.e. Text, Number or Date. 

4. Click either Ascending or decending  

5. Click OK. 

 

Mail merge document 

Mail merge is the process of generating personalised letters or documents by combining a 

main document, e.g. a letter, with an existing data source such as the address book. 

Therefore in mail merge, the three files created are: 

1. The primary file (main document)  

2. The secondary file (Data source)  

3. Merged file 

To create the main document, 

 

1 From the file menu, select New to create a new document. You can also open or 

retrieve an existing document. 

2. On the Tools menu, click mail merge to display a dialog box. 

3 Click create button, to select the type of document needed e.g. form .letters. Select the 

active window as the main document this means that the currently running document will 

be the form letter that will be later merged with a data source to produce individualised 

letters. 

The next step is now to create a data source. 

4. Click Get Data. To use an existing list of names and addresses, click 

Open Data. Source To use existing addresses from an electronic address book, click on 

Use Address Book. To create a new list of names and addresses, first choose the 

necessary fields from the create data source box then save the record structure. A 

message appears asking you whether you want to edit the data source or the main 

document choose one then the Next.  

5. With the main document open, spot the mail merge toolbar on the screen. Position the 

text cursor where you want to insert merge fields. Use the insert field’s button to insert 
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merge fields in the document 

Merging the document 

Once you finish inserting merge fields from the data source in the main document, you 

are now ready to merge. There are several merge options: 

 

To merge to a new document 

Click the Merge to new document icon on the mail merge toolbar. 

 

Merging to printer 

Click the .Merge to printer, icon on the mail merge toolbar. Before you merge to a printer 

or other device, you may want to preview the appearance of the merged documents. For 

example, you can preview the merged documents one at a time. You can also collect the 

merged documents into a new document, so you can review and personalise the 

documents. 

 

Preview merged documents 

Before you print the documents, ensure that you've inserted merge fields in the main 

document and selected a data source. To preview, click anywhere in the main document, 

and then click View Merged Data on the Mail Merge toolbar. 

 

Microsoft Word displays information from the first data record in place of the merge 

fields. 

 

Send merged documents via e-mail or fax 

Click the merge button on the Mail merge toolbar Select e-mail or fax in the merge to 

box. Click the Setup button to specify the e-mail addresses or faxing number then click 

the merge button. The internet connection wizard starts and if your computer is properly 

configured, the mail merged document will be sent. 

Inserting graphics 

 

Working with graphics 

The term graphics refers to non-text images generated by a compute! This includes 

photographs, drawings and graphs. Graphics present information in a form that is easy to 

understand. 

 

You can insert a graphical object from Microsoft Clip Gallery, a scanner or by using 

drawing tools available in Microsoft Word. 

 

Inserting a clip art or a picture from clip gallery: 

1. Position the insertion pointer where you want your object to be inserted, 

2. On the insert menu, point to picture  then click clipart Click on the tabs to select on the 

category of objects i.e. clip art, pictures, sound or videos. See Figure 1.42. 

3. Double click on the object you want or click it once then click the insert button. 

 4. Use the object place holders to resize your object. If you place the mouse pointer on 

one of these holders, it turns into a two headed arrow, hold down the mouse button and 

drag to increase or reduce the object size 
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5. Click anywhere outside the object to remove the holders. 

6. To move you object to another position, click inside the object. The pointer turns into 

an arrowhead cross. Hold down the mouse button and drag your image to a new location. 

 
Fig. 1.42: A clip art image 

Inserting an image from a scanner 

The computer must be connected to a scanner to complete this procedure. A scanner is a 

data capture device that transforms a hand copy or real graphical object into digital form. 

 

To scan an object: 

1. Position the insertion pointer where you want your picture to appear, 

2. from the insert menu, point to Picture and then click from scanner or Camera. 

3. To scan, follow the instructions that come with your scanner. 

4. When the image appears on the screen you can edit and format it as required the same 

way you would with a clipart. 

 

Inserting a picture from another file 

1. Position the insertion pointer where you want your picture  placed,  

2.  From the insert menu, point to Picture, then click "From file 

3. Locate the file that contain the image you want to insert eg from your floppy disk, 

from a compact disk etc. 

4. Select the object you want to insert 

5 Then click the Insert button. 

6 When the image appears on the screen you can edit and format it as required the 

same way you would with a clipart. 

 

Editing and formatting pictures 

 

To format or edit a picture: 

Microsoft Word provides the user with a picture editing toolbar that lets you adjust the 

brightness, contrast, change it to black and white or grayscale and crop the image. 

Cropping refers to hiding the unwanted details so that they do not come out when 

printing. 

 

To display the picture toolbar, click on View menu, point to toolbars then select Picture. 

The picture toolbar has buttons that enable a person to format a picture to format a 
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picture, click it to select it then use the commands on the picture toolbar. 

 

Drawing an object using MS Word drawing tools 

Microsoft Word provides the user with basic drawing tools such as polygons, lines, a 

circle, stars and banners, call outs and many others. If the drawings toolbar is not 

displayed, click on View menu, toolbars then click on Drawing. The toolbar will be 

displayed which a button has labeled Auto shapes, an arrow, a line, square and a circle 

 

To draw a line, a circle an arrow or a rectangle: 

1. Click on the appropriate shape button. The pointer changes to a plus sign. 

2. Place the pointer where you want to draw that shape and drag to the required size. 

 

To draw an object using the Auto shapes: 

1. Click the Auto shapes button. A menu is displayed showing categories of shapes you 

can choose from 

2. Point to the category required then select the type of object you wish to draw 

3. Place the pointer where you want to draw that shape and drag to the required size. 

 

Editing and formatting a drawn object 

You can resize, move, fill color and change the drawing outline. 

 

To resize or move a drawing. 

1. Click anywhere inside it. The place holders appear. 

2. To move it, hold down the mouse button and drag. 

3. To resize it, place the pointer at one of the place holders and drag. 

 

To fill the object with color and fill effects: 

1 Click the object. The place holders appear. 

2 Click the down arrow of fill color button, the one that looks like a bucket pouring ink. 

3 Select the color you want applied. To fill the drawing with texture, gradient or pattern, 

click the Effects button. From the resulting dialog box, select the appropriate fill effect. 

Printing a document 

 

Printing in Microsoft Word 

Because the main purpose of any word processor is to prepare documents for printing, 

this cannot be accomplished without a printer. The choice of a printer depends on the 

quality of hardcopy desired. Before you print, it is very important that you preview you 

document to confirm that no details are outside the printable area and that the document 

layout is okay. 

 

Using print preview 

In Microsoft Word, to view your document before printing proceed as follows: 

1. From file menu, select print preview the mouse pointer changes into a symbol that 

resembles a magnifying glass. You can click on the mouse button inside the document to 

increase or reduce the size of the view. 

2. Click the close button or Esc key to return to your document. 
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To print: 

 

1. From file menu click on print A dialog box appears where you can specify: 

(a) The type of the printer installed in your computer other than the default printer. 

(b) Whether to print the whole document or a range in the Page range box, 

(c) Number of copies to print per page in the Number of copies box then, 

2. Click OK to start printing. 
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SPREADSHEETS MS-EXCEL 

 

Chapter outline 

 

2.1 Definition of spreadsheet 

2.2 Components of a spreadsheet 

2.3 Application areas of a spreadsheet  

2.4 Creating a worksheet/workbook using Microsoft Excel 

2.5 Cell data types 

2.   Cell referencing 

2. 7 Basic functions and formulae 

2.8 Editing a worksheet 

2.9 Worksheet formattin2.10 Data management 

2.11 Charts/graphs 

2.12 Printing worksheets 

 

2.1 Definition of a spreadsheet 

A spreadsheet is essentially a ledger sheet that lets you enter, edit and manipulate 

numeric data. There are two types of spreadsheets namely: 

1. The manual spreadsheet. 

2. The electronic spreadsheet. 

A manual spreadsheet is the most commonly used type by book keepers as a ledger book 

with many sheets of papers divided into rows and columns on which various amounts of 

money are entered manually using a pen or pencil. You can visit your bursar's office and 

request to see a ledger sheet. 

 

An electronic spreadsheet on the other hand is prepared using a computer program that 

enables the user to enter values in rows and columns similar to the ones of the manual 

spreadsheet and to manipulate them mathematically using formulae. ' 

 

In this book, the word spreadsheet shall be used to refer to the electronic spreadsheet. '. 

Advantages of Using Electronic Spreadsheets over Manual Spreadsheet 

 

1. The electronic spreadsheet utilizes the powerful aspects of the computer like speed, 

accuracy and efficiency to enable the user quickly accomplish tasks. 

2. The electronic spreadsheet offers a larger virtual sheet for data entry and manipulation. 

For example the largest paper ledger you can get is one that does not exceed 30 columns 

and 51 rows while with an electronic spreadsheet, the least ledger has at least 255 

columns and 255 rows! 

3. The electronic spreadsheet utilizes the large storage space on  computer storage 

devices to save and retrieve documents. 

4. The electronic spreadsheet enables the user to produce neat work because the 

traditional paper, pencil, rubber and calculator are put aside. All the work is edited on the 
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screen and a final clean copy is printed. With a handwritten spreadsheet, neatness and 

legibility depends on the writer's hand writing skills. 

5. Electronic spreadsheets have better document formatting capabilities. 6. Electronic 

spreadsheets have inbuilt formulae called functions that enable the user to quickly 

manipulate mathematical data. 

7. An electronic spreadsheet automatically adjusts the result of a formula if the values in 

worksheet are changed. This is called the automatic recalculation feature. For a manual 

sheet, changing one value means rubbing the result and writing the correct one again. 

 

Examples of spreadsheets 

1. VisiCalc: This was the first type of spreadsheet to be developed for personal 

computers. 

2. Lotus 1-2-3: This is integrated software with spreadsheet module graphs and database. 

3. Microsoft Excel 

4. VP-Planner etc. 

In this book, the spreadsheet that will be considered in details is Microsoft Excel. 

Components of a spreadsheet 

A spreadsheet has three components   

1. Worksheet. / 

2. Database. 

3. Graphs. 

Worksheet 

This is the component in which data values are entered. It is made up of rows and 

columns. The intersection between a row and a column is called a cell. A row is a 

horizontal arrangement of cells while a column is a vertical arrangement of cells. Each 

row is labeled with a number while each column is labeled with a letter as shown in the 

Figure 2.1. Each cell is referenced using the column label followed by the row label e.g. 

cell B3 has the value 20. A group of many worksheets make up a workbook. 

 

                                                    A             B       C          D        E         F 

1            

2            

3  20          

4            

5    I        

 

Fig. 2.1: A Worksheet 

 

Database 

Data values can be entered in the cells of the spreadsheet and managed by special Excel 

features found on the Data menu. These features were incorporated in Excel but they 

actually belong to database management software. One of such feature is filtering 

records, using forms, calculating subtotals, data validation pivot tables and pivot chart 

reports. 
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If the data values for the same entity (related values) are entered on the same row, they 

form a record. Hence a worksheet can be manipulated to some extent as a database that 

has data records entered in it. Figure 2.2 shows a worksheet having two records, Joy and 

Jeff. 

 

                                                            A              B             c           D            EF1 

   1 Name IDNo. Age Nationality 

   2 Joy 123445 25 Kenyan 

   3 Jeff 125675 35 Ugandan 

   4     

 

Fig. 2.2: A spreadsheet with records 

 

NB: A spreadsheet file is structured in such a way that it can be visualised as a table of 

records. That is why such a 'file can be imported into a database program as will be 

discusses later in databases. 

 

Graphs 

A graph is a pictorial representation of the base data on a worksheet. Most spreadsheets 

refer to graphs as charts. A chart enables the user to present complex data elements from 

a worksheet in a simple easy to understand format. Examples of charts are pie charts, line 

charts and bar charts. As shall be discussed later, it is easy to generate charts when 

working with a spreadsheet program. Figure 2.3 shows an example of a pie chart. 

 

2.3 Application areas of a spreadsheet 

 

Statistical analysis 

Spreadsheets provide a set of data analysis tools that can be used to save steps when 

developing complex statistical or engineering analyses. The user is usually expected to 

provide the appropriate data and parameters for each analysis. The statistical tool then 

uses appropriate automated statistical or engineering functions and then displays results 

in an output table. Some of the tools generate charts in addition to the output tables. 

 

Because most of these tools are complex, the user needs to have the statistical 

background knowledge before attempting to use the tools. Examples of some simple 

statistical functions include the following: 

1. Average: This is used to calculate the mean of a set of values. 

2. Median: This is used to return the value in the middle of a set of values. 

 

For example a set of values may be composed of: 

 

10   20    30   40    50     60. 

 

The average of the set is 35 and its median is also 35. The median is found by taking the 

average of the two numbers at the centre of the set, in this case 30 and 40. 
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Accounting 

Many accountants find the spreadsheet a useful tool to use in recording daily transactions 

and keeping of financial records. Spreadsheets provide a user friendly environment for 

financial management and they come with inbuilt functions that make accounting tasks 

easier. For example, the spreadsheet can be used by accountants to do the following: 

1. To track the value of assets over time (depreciation and appreciation)  

2. To calculate profits 

3. To prepare budgets 

 

Other formula like sum, average, product etc. enables the accountant to carry out his 

daily work without any problem. 

 

Data management 

A spreadsheet enables neat arrangement of data into tabular structure. Related data can be 

typed on the same worksheet. However, when data is on different worksheets, the 

worksheets can be linked to enhance accessibility. 

 

Data management functions include sorting, filtering (displaying only the required items) 

and using forms to enter and view records. 

 

Spreadsheets enable the user to create, edit, save, retrieve and print worksheet data and 

records. 

 

Forecasting ("What if" analysis) 

The automatic recalculation feature enables the use of "What if' analysis technique. This 

involves changing the value of one of the arguments in a formula to see the difference the 

change would make on the result of the calculation. For example, a formula to calculate a 

company's profit, margin may be as follows: 

 

Profit =, (Total units sold x sale price) - (Total units bought x cost price)  - Operating 

‘expenses. 

A sales manager in the company c n ask the following question: What if sales increase by 

20%, how much profit wills the company make? The manager substitutes the total units 

sold value with one that is 20% higher and the spreadsheet automatically displays the 

new profit. A traditional analysis method would require a different work sheet to be 

prepared. Therefore, this method can be used for financial forecasting, budgeting, stock 

portfolio analysis, cost analysis, cash flow etc. 

Creating a worksheet/workbook using Microsoft Excel 

To start Microsoft Excel, click Start button, point to Programs and then select Microsoft 

Excel from the programs menu This procedure may vary slightly depending on the 

version of Excel you are using or the computer's hardware and software configuration. 

The Windows environment allows a person to place shortcuts to a program's executable 

(.exe) file in various places like the desktop. If the Excel shortcut is on the desktop, 

simply double click it to start the application. 
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The Microsoft Excel application window opens as shown in the Figure 2.5. Make sure 

that you can be able to identify all the labeled parts of the Microsoft Excel application 

window. 

 

The Microsoft Excel application window 

The Microsoft Excel application window is made up of the following components:  

 Title bar: It has the title of the application and control buttons for minimising, 

maximising and closing the application 

The menu bar: It displays a list of menu options e.g. File, Edit, View etc. Clicking one of 

them displays a menu that has commands which can be selected in order to manipulate 

data in the spreadsheet. ' 

Tool bars: The most common of these are the standard and formatting toolbars. The most 

important thing is to be able to identify each toolbar by its icons. The standard toolbar has 

shortcuts to some of the most commonly used menu commands like print, copy, paste and 

save. The formatting toolbar has shortcuts to the commonly used commands found on the 

format menu option  

Formula bar: This is one of the most important components of the Microsoft Excel 

application window. It enables the user to enter or edit a formula or data in a cell. You 

can identify the formula bar because it has an equal sign (or fx). The name box to the left 

of the formula bar displays the position of the cell in which data or a formula is being 

entered which is also called the current cell. If the formula bar is not available, click on 

View menu then select Formula bars. A check mark appears on the left of the selected 

item to show that it is now displayed on the screen. 

Cell pointer: It marks the position of the current cell or the insertion point. It is special 

cursors that is rectangular in shape and makes the current cell appear as if it has darker 

boundaries. 

The Worksheet: Consists of cells, rows and columns. Data is entered here for 

manipulation. 

Status bar: It shows the processing state of the application. For example, on its left is the 

word Ready which shows that the spreadsheet is ready to receive user commands. ' 

 

Worksheet labels: These are usually of the format Sheet 1, Sheet 2 etc. A workbook may 

have several sheets. It is also possible to rename the sheets by right clicking on the labels 

then choosing rename command from the shortcut menu that appears. The active sheet 

(one being used) has its label appearing lighter in colour than the rest. To move to a 

particular sheet in the workbook, simply click its sheet label. 

 

Vertical and horizontal scroll bars: Clicking the arrows at their ends moves the 

worksheet vertically and horizontally on the screen respectively. 

 

Worksheet layout 

The worksheet has the following components: Cells: An intersection between a row and a 

column. 

Rows: Horizontal arrangement of cells. Columns: Vertical arrangement of cells. 

Range: Is a group of rectangular cells that can be selected and manipulated as a block. 
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Navigating the Microsoft Excel screen 

1. Click cell D5. Notice that the cell pointer immediately moves to the cell and the name 

box reads D 5. Typing on the keyboard now inserts entries in cell D5 as long as the 

pointer is still there. 

2. Click letter A that heads the first column. Notice that the whole column is highlighted. 

3. Double click cell EIO. Notice that the text cursor forms in the cell and you can now 

type characters inside the cell. Also the status bar will now read enter which means that 

Microsoft Excel expects you to enter a value in the cell. 

4. Click the down arrow on the vertical scroll bar. The worksheet moves upwards on the 

screen. The opposite happens when you click the up arrow on the vertical scroll bar. 

5. Click the right button on the horizontal scroll bar. The worksheet moves to the left. 

The opposite happens when you click the left button on the horizontal scroll bar. 

6. Press the right arrow key on the keyboard. Notice that the cell pointer moves one 

column to the right on the same row. This can also be done by pressing the Tab key once. 

7. Press the left arrow key on the keyboard. Notice that the cell moves one column to the 

left on the same row. Pressing gives the same results. 

 

8. Press the up arrow key on the keyboard. Notice that the cell pointer moves one row up 

on the same column. 

9. Press the down arrow key on the keyboard. Notice that the cell pointer moves one row 

down on the same column. 

10. Press the end key. The status bar will display the message "END". If you press the 

right arrow key, the cell pointer will move right to the last cell on the row. If the left up or 

down keys were to be pressed instead, the cell pointer would move to the last cell to the 

left, top or bottom respectively. 

 

11. Pressing Ctr1+Home moves the cell pointer to the first cell of the worksheet i.e. cell 

AI. 

 

Creating a worksheet 

At its simplest level, creating a worksheet consists of starting the spreadsheet program 

and entering data in the cells of the current worksheet. , However, a person can decide to 

create a worksheet either using the general format or from a specially preformatted 

spreadsheet document called a template. 

 

Using the general format 

When a spreadsheet program is running it will present the user with a new blank screen 

of rows and columns. The user can enter data in this worksheet and save it as a newly 

created worksheet. If this is not available then click File menu option and select the new 

command. The dialog box shown in Figure 2.8 will be displayed on the screen. On the 

General tab, double click the workbook icon. Enter data in the new worksheet created. 
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Using a template 

Click File menu option then new command. On the spreadsheets solutions tab, double 

click the template that you wish to create. Figure 2.9 below shows some examples of 

templates that may be present for selection. 

 

NB: If the template was saved previously on the hard disk, it will open as a new 

worksheet with all the preformatted features present allowing the user to enter some data. 

However, some templates may require the original program installation disk in order to 

be able to use them because they may not have been copied to the hard disk during 

program installation. 

 

Editing a cell entry 

Editing a cell means changing the contents of the cell. Before the contents in a cell can 

be. Changed, the cell must be selected by making it the current cell. 

To edit a cell entry proceeds as follows: 

.1. Move the cell pointer to the cell you wish to edit. 

 2. Double click the formula bar for the text cursor to appear in the bar. The status bar 

message changes to edit 

3. Use the keyboard to delete and add contents to the formula bar then press enter key to 

apply. Click the save button on the standard toolbar to save the edited changes. 

 

Selecting a range 

As you have experienced with the previous two examples, working with one item at a 

time is tedious and time consuming. Using a range saves time when working with a large 

.amount of data. 

 

A range is a rectangular arrangement of cells specified by the address of its top left and 

bottom right cells, 'separated by a colon (:) ego Range AI:CIO is as shown in Figure 2.10. 

Selecting multiple ranges 

When using a mouse, you can select more than one range without removing the highlight 

from the previous. To do this: 

Hold down the Shift key or the Ctrl key while you click on the row header of the second 

range you want to highlight. What happens? Do you notice the difference when holding 

down the shift and the ctrl keys? 

1. Shift key will cause all columns/rows between the selected and the newly clicked cell 

to be highlighted. 

2. Ctrl selects individually clicked cells or range. 

 

Hiding rows/columns 

You can hide some rows or columns in order to see some details, which do not fit, on the 

screen. To do this: 

1. Highlight the columns/rows you want to hide 

2. Click format menu, point on row or column and click hide command. 

 

Saving a worksheet 
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To save a worksheet, one has to save the workbook in which it belongs with a unique 

name on a storage device like a hard disk. The procedure below can be used to save a 

workbook: 

1. Click File menu option then select Save as' command. Alternatively, click the save 

command on the standard toolbar. The save as dialog appears  

2. Select the location in which your workbook will be saved in the Save in box then type 

a unique name for the workbook in the File name box. Make sure that the option 

Microsoft Excel Workbook is selected under the save as type box. 

3. Click the Save button to save. 

 

Retrieving a saved workbook 

This means opening a workbook that was previously saved. 

1. Click File menu option then the Open command. Notice that the Open command has 

three dots (called ellipsis) indicating that a dialog box will open, as the user is required to 

provide additional information. Alternatively just click the Open command on the 

standard toolbar. The open dialog box appears on the screen. 

2. Click the Look in drop down list arrow and select the drive or folder where the 

workbook was saved. For example, if you saved in a diskette, insert it in the floppy drive 

then select 3 1/2-floppy (A:). A list of folders and files in the drive will appear in the list 

box. 

3. Double click the icon of the workbook you want and the worksheet will be displayed 

in the Microsoft Excel window. Notice that the cell pointer is in the same cell it was in 

when the worksheet was last Saved. 

Closing a worksheet 

Click File then Close command. This closes the worksheet but does not 

Close the Excel spreadsheet program. Alternatively, click the; close button of the 

worksheet window 

Exiting from the spreadsheet  

Click File then Exit command. This closes not only the worksheet but also the 

spreadsheet program as well. Alternatively click the close button of the main application 

window.  

Cell data types 

There are four basic types of data used with spreadsheets: 

1. Labels 

2. Values, 

3. Formulae 

4. Functions. 

 

Labels 

Any text or alphanumeric characters entered in a cell are viewed as labels by the 

spreadsheet program. Labels are used as row or column headings usually to describe the 

contents of the row or column. For example, if a column will have names of people, the 

column header can be NAMES. Sometimes, numbers can be formatted so that they can 

be used as labels. To achieve this add an apostrophe just before the most significant digit 
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in the number. For example, the number 1990 will be treated as numeric. if typed in a cell 

but' 1990 will be treated as a label. 

 

Labels are aligned to the left of the cell and cannot be manipulated mathematically. 

 

Values 

. , 

These are numbers that can be manipulated mathematically. They may include currency, 

date, numbers (0-9), special symbols or text that can be manipulated mathematically by 

the spreadsheet. 

 

Formulae 

These are user designed mathematical expressions that create a relationship between cells 

and return a value in a chosen cell. In Microsoft Excel, a formula must start with an equal 

sign. For example, the formula 

=B3+D4 adds the contents ofB3 and D4 and returns the sum value in the current cell. 

 

Excel formulae use cell addresses and the arithmetical operators like plus (+) for addition, 

minus (-) for subtraction, asterisk (*) for multiplication and forward slash (I) for division. 

Using cell addresses, also called referencing, enables Microsoft Excel to keep 

calculations accurate and automatically recalculates results of a formula in case the value 

in a referenced cell is changed. This is called automatic recalculation. 

 

Functions 

These are inbuilt predefined formulae that the user can quickly use instead of having to 

create a new one each time a calculation has to be carried out Microsoft Excel has many 

of these formulae that cover the most common types of calculations performed by 

spreadsheets. To add the contents of cell B3 and D4 the sum function can be used as 

shown below: 

 

= Sum (B3:D4) 

 

2.6 

 

Cell referencing 

A cell reference identifies a cell or a range of cells on the worksheet and shows Microsoft 

Excel where to look for the values or data needed to use in a formula. With references, 

you can use data contained in different cells of a worksheet in one formula or use the 

value from one cell in several different formulae. 

By default, Microsoft Excel uses the A 1 cell referencing style. This means that a cell is 

identified by its column label followed by the row number. However, the Rl Cl 

referencing style can be used. In this case, the cell is referencing by its row number 

followed by its column number. The table below gives a few examples of equivalent 

referencing using both styles.   

A1 style R1C1 style 

B2 R2C2 
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C10 R10C3 

E20 R20C5 

 

 

The RlCl style is useful when automating commonly repeated tasks using special 

recording programs called Macros. 

 

Relative referencing 

When performing tasks that require cell referencing, you can use formulae whose cell 

references keep on changing automatically depending on their position in the worksheet. 

This is called relative cell referencing. A good example would be if you type the formula 

=Al+Bl in cell Cl. If the same formula is copied to cell C2 the formula automatically 

changes to =A2+B2. 

 

Absolute referencing 

These are cell references that always refer to cells in a specific location 

, of the worksheet even if they are copied from one cell to another. To make a formula 

absolute, add a dollar sign before the letter and/or number, 

such as $B$lO. In this case, both the column and row references are absolute. . 

 

Referencing using labels and names 

Labels of columns and rows on a worksheet can be used to refer to the cells that fall 

within those columns and rows. It is possible to create a name that describes the cell or 

range then use it instead of having to specify a range with actual cell references. Such a 

descriptive name in a formula can make it readable and easier to understand its purpose. 

For example, the formula =SUM(SecondQuarterProfits) might be easier to identify than 

=SUM(AlO:C20). In this example, the name SecondQuarterProfits represents the 

rangeAlO:C20 on the worksheet. Names can also be used to represent formulae or values 

that do not change (constants). For example, you can use the name .Tariffs to represent 

the import tax amount (such as 7.0 percent) applied to imports. 

 

To create a named range 

To create a named range proceeds as follows: 1. Select the range to be named: 

2. Click inside the name box to move the text cursor inside. Delete the Cell reference that 

is there and type a name for the range. 

3. Press Enter key to apply. Figure 2.13 shows a worksheet range called sales that has 

values used in a formula to give the sum in cell C 11. 

 

 

2.7 Basic functions and formulae 

Formulae perform mathematical operations ranging from very simple arithmetic 

problems t9 complex scientific, financial and mathematical analysis. 

 

Statistical functions. 
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1. Average: It returns the average (mathematical mean) of a set of values which can be 

numbers, arrays or references that contain numbers. If the value 20 is in cell DIO and 30 

in ElO then: 

 =Average(D lO:E 1 0) returns 25 as the average of the two values. 

2. Count: Counts the number of cells that contain values within a range e.g. 

 = count (AIO: EIO) many return a value 5 if all the cells have values. 

3. Max: It returns the largest value in a set of values. It ignores text and logical values e.g. 

== Max (AlO:EIO) will return the maximum value in the range. 

4. Min: It returns the smallest value in a set of values. It ignores text and logical values 

e.g. = Min (AIO:EIO) will return the minimum values in the range. 

5. Mode: It returns the most frequently occurring value in a set of values. e.g. = Mode 

(AIO:ElO) 

6. Rank: Returns the rank of a number in a list by comparing its size relative to the others. 

For example if A 1 to AS contains numbers 7, 3.8,3.8, 1 and 2 then RANK (A2, Al 

:A5,1) returns 3 while RANK (AI, AI:A5,I) returns  

5. The general format is RANK (number to be ranked, range, order). 

 

Logical functions 

1. If: It returns a specified value if a condition is evaluated and found to be true and 

another value if it is false. If (marks > 50, "pass", "fail") will display a pass if values are 

more than 50 else it will display fail. 

2. Countif: Counts the number of cells within a specified range that meet the given 

condition or criteria. e.g. suppose A 1 0 : E 1 0 contains eggs, beans, beans, eggs, eggs, 

countif(AIO:EIO, "Eggs") will return 3. 

3. Sumif: It adds values in the cells specified by a given condition or criteria. e.g. For 

example if AIO to ElO contains values 10,50,60, 30, 70, to sum all values greater than 50 

= Sumif(AIO:EIO, ">50"). This returns 130. 

 

Mathematical functions 

1. Sum: adds values in a range of cells as specified and returns the result in the specified 

cell. e.g Sum (AIO:EIO) adds values in the range 

2. Product: multiplies values in a range of cells and returns the result in the specified cell. 

For example if A 10 has 30 and BIO has  

3. Product (AlO:BIO) will return 90. 

 

Arithmetic formulae - using operators  

 Operator Function 

 

+ (plus)                                          adds values as specified 

- (minus) .                                      subtracts values as specified 

* (multiplication)                           multiplies values 

/ (division)           divides values. 

( ) parenthesis    encloses arguments to be calculated first. 

 

For a formula =(Al +C3)/E20, if the value in E20 is not zero, the result is displayed in the 

current cell. 
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Order of execution 

If several. Operators are used in a single formula; Microsoft Excel performs the 

operations in the order shown in Table 2.3. Formulas with operators that have same 

precedence i.e. if a formula contains both a multiplication and division operator are 

evaluated from left to right. Enclosing part of the formula to be calculated in parentheses 

or brackets makes that part to be calculated first. 

 

Operator  Name Precedence 

1. -  Negation as in -1 1 

2.%  Percent 2 

2. 1\  Exponentiation 3 

3. * and / ! Multiplication and division 4 

4. + and -  Addition and subtraction 5 

6. =,<>,>,<,<=,>= Relational 6 

 

Table 2.3: Operators' order of execution 

 

2.8 

 

Editing a worksheet 

 

Coping and moving data 

Spreadsheet software automates many processes that could have been tedious if done 

manually. For example with Microsoft Excel, you can do calculations using formulae 

fairly easily as you give the data and correct instructions to the program. Copying and 

moving of, data can also be done quickly and efficiently. 

 

When data is cut or copied from the worksheet, it is temporarily held in a storage location 

called the clipboard. 

 

Copying data 

To copy a cell or a range of cells: 

1. Highlight the cells or range you want copied 

2. Click the Edit menu then select Copy command. 

3. Select the cell in which you want to place a copy of the information 4. From the Edit 

again, click Paste command. The Paste command puts a copy from the clipboard on the 

specified location 

 

Moving data 

Unlike the Copy command where a duplicate copy is created, the Move command 

transfers the contents of the original cell (s) to a new location. 

 

To move a range of cells: 

1. Highlight the range you want to move. 

2. From the Edit menu, select Cut. 
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3. Specify the location you want to move the contents to.  

4. From the Edit menu again, click Paste. 

 

2.9 Worksheet formatting 

Worksheet formatting refers to enhancing the appearance of the worksheet to make it 

more attractive and appealing to the reader. Appropriate formatting should be used to lay 

emphasis, catch attention and bring otherwise II hidden detail to the fore of the document. 

 

The golden rule of formatting is to use simple clear formats. It essentially consists of 

changing text colour and typeface (font), size, style and alignment. In Microsoft Excel, 

format the cells whether empty or not and their contents will acquire the set format 

automatically. 

 

To format a single cell, make it the current cell then format menu option and select the 

cells command In the format cells dialog box, make the formatting specifications that you 

wish then click the ok button to apply. If it is a range of cells, they must be highlighted 

first before formatting them as a block of cells. 

 

Formatting text 

1. Highlight the cells that have the text to be formatted. 

2. Click Format menu then cells command. The dialog box appears 

3. Select the font tab as shown in the figure by clicking it. 

4. Select the font type e.g. Times New Roman. Other font formatting features like style, 

size, underline and colour are available and can be selected. 

5. Click button to apply. 

 

NB: Alternatively, use the formatting toolbar to accomplish all your text formatting 

needs. Notice that the options in the font dialog box are commands on the formatting 

toolbar. 

 

Formatting numbers 

1. Highlight the cells that have the numbers to be formatted. 

2. Click Format menu then cells command. The dialog box in Figure 2.15 appears. 

3. Select the Number tab as shown in the figure below. 

4. You can now choose number formats as explained below: 

Number            Meaning 

General  general format cells have no specific number format.  

Number Used for general display of numbers e.g. 2345.23.  

Currency For displaying general monetary values e.g. $100, Ksh.10. 

Accounting Lines up the currency symbols and decimal poin s. Displays date in 

chosen format. 

Date  Displays time in chosen format. 

Percentage       Multiplies the value in a cell with 100 and display ' it as %. 

Text  Formats cells to be treated as text even when numbers are entered. 

Custom          For a number format not predefined in Microsoft Excel, select custom then 

define the pattern. 
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Worksheet borders 

You may need to put a printable border around your worksheet or in a range of cells to 

make it more attractive and appealing. To put a border: 

1. Highlight the range you wish to insert borders. From the format  menu, click cells 

command. 

2. Click the borders tab and specify the border options for left, right, top and bottom. . 

3. From the style options, select the type of line thickness and style. Also select the preset 

options. 

4. Click the ok button. The selected range will have a border around it. 

 

Formatting rows and columns 

Sometimes, the information entered in the spreadsheet may not fit neatly in the cell set 

with the default height and width. It therefore becomes necessary to adjust the height of a 

row or the width of a column. The standard width of a column in Microsoft Excel is 8.43 

characters but can be adjusted to any value between 0 and 255. 

 

Changing column width 

1. Move the mouse pointer to the right hand side line that separates the column headers 

i.e. for instance the line between A and B. 

2. Notice that the mouse pointer changes from a cross to a double arrow 

3. Click the mouse button and hold it down so that you can now resize the width of the 

column by dragging to the size you wish. After Dragging to the required point release the 

mouse button and the Column will have a new size. 

 

NB: Alternatively, move the cell pointer to one of the cells of the column then click 

Format, point to Column then click Width command from the sidekick menu. Type a 

width in the dialog box that resembles Figure 2.17 then click Ok.button to apply. 

NB: To change the widths of several columns at the same time, highlight them first 

before following this method. 

 

Changing row height 

1. Point to the line that separates two row numbers e.g. the line between 1 and 2. The 

mouse pointer becomes a double arrow. 

2. Drag the line until the height of the row is as required then stop and release the mouse 

button. 

NB: Alternatively, click Format point to Row then click Height from the sidekick menu 

that appears. Type the height that you wish in the dialog box that appears and then click 

OK button to apply. 

 

Inserting rows and columns 

I, Click cell A5 to make it the current or active cell. 

2.clik insert then columns to insert a 'row above cell A5 and shift all the other rows 

downward. 

OR 
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Click insert then Columns to insert a column to the left of column A and shift all the 

others to the right. 

 

NB: Alternatively, click  insert  then cells to display the dialog box select the entire row 

or entire column options to insert a row or column respectively. 

 

Global worksheet formatting 

The word global in this case refers to the entire worksheet. In order to format the whole 

worksheet globally, it must be selected as a whole. 

Two methods can be used to select a worksheet globally: 

1. Click the top left comer of the worksheet that has a blank column header i.e. 

immediately on the left of A and just above I, 

OR 

2. Press Ctrl+A on the keyboard. 

 

Notice that the whole worksheet becomes highlighted. It can now be formatted as one big 

block using format cells command. 

 

Using autoformat 

It allows the user to apply one of sixteen sets of formatting to & selected range on the 

worksheet. This quickly creates tables that are easy to read and are attractive to the eye.. 

1. Select a range e.g. B 1 :G7 to make it active. 

2. Click format then select the auto format command on the menu that Appears. Select a 

format from the autoformat dialog box shown in Figure 2.19. 

3. Click the ok button to apply the format to the selected range. 

 

2.9 Data management 

At times, it becomes necessary to use advanced data management tools to manage large 

,data stored on a 'worksheet. For example, if the worksheet has many records, it may 

become necessary to arrange them in a particular order using a method called sorting for 

easier access to data items. Other methods of data management include use of filters, 

total/subtotal function and forms. 

 

Sorting 

To carryout sorting proceed as follows: 

1. Highlight the range that you wish to sort by clicking its column header letter.  

2. Click Data then Sort . Notice that the Sort by field is already reading the field that you 

selected. This field is called the criteria field. 

3. Select the field to be used as the key for sorting and the sort order as either descending 

or ascending then click OK button to apply. 

 

Filtering data 

Filtering is a quick and efficient method of finding and working with a subset of data in a 

list. A filtered list will only display the rows that meet the condition or criteria you 

specify. Microsoft Excel has two commands for filtering lists. 
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1. The auto filter: It uses simple criteria and includes filter by selection.  

2. Advanced filter: It uses more complex criteria. 

 

In this Pupil's Book we will look at the autofilter. 

 

Autofilter 

Filters can be applied to only one list on a worksheet at a time. 

1. Click a cell in the list that is to be filtered; usually the list is in a column. 

2. On the Data menu, point to Filter, and then 

3. To display only the rows that contain a specific value, click the arrow in the column 

that contains the data you want to display as shown in Figure 2.21. 

4. Click the value that is to be displayed by the filter from the drop  down list. e.g in the 

example below, the selected value is 34. 

NB: Sometimes while looking through a list of values on a large worksheet, you may 

come to a value of interest and want to see all other occurrences of the value in the 

spreadsheet. Simply click the cell that has the value then click auto filter on the standard 

toolbar. Microsoft Excel turns on AutoFilter and then filters- the list to show only the 

rows you want. 

 

Subtotals function 

Consider the following scenario: A company that has many salespersons 

will need to know how much each of them should be paid at the end of a period by 

looking at individual sales volumes. Also, the grand total for all the payments has to be 

calculated. Therefore, if the salespersons are held in a list, there would be need to 

calculate the amount due to each of them. This can be called a subtotal in the list. All the 

subtotals can then be added together to make the grand total. Consider the following list: 

Name                 Amount Owed 

Stephen  ` 6000 

Joy   3000 

 Stephen  2000 

 Virginia  5000 

 Joy    800 

Stephen  200 

 Virginia  5000 

 

Microsoft Excel can automatically summarise the data by calculating subtotal and grand 

total values of the list. To use automatic subtotals, the list must have labelled columns 

and must be sorted on the columns for which you want subtotals. In this example, the list 

is first sorted by name 

1. Click a cell in the list that will have subtotals e.g. cell A3. 

2. On the Data menu click Subtotals 3. Notice that all the data range is now selected. 

3. In each change in box, select Name from the drop down list because we want a 

subtotal for each of the names. 
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4. In the Use function box select the sum function  then select the list for which subtotals 

will be inserted in the add subtotals box by checking the appropriate label. In this case it 

is the amount owed field. 

5. Click ok button to apply and the list will now have sub totals inserted   

Totals function 

Use theAutoCalculate feature in Microsoft Excel to automatically show the total of a 

selected range. When cells are selected, Microsoft Excel displays the sum of the range on 

the status bar. Right clicking this function displays other functions like Min, Max and 

Average that can also be used. To find the total of a range, highlight it then click the 

autosum icon ∑ on the standard toolbar. 

 

Forms 

A form is a specially prepared template that the users can use to enter data in a 

worksheet. It is specifically formatted to enable users to enter data in a format that is 

more convenient to them. If data is collected on paper before entering in the computer, 

then a form can be created to have the layout of the data on the paper to quicken data 

entry procedures. To display a form: Click 'Data, then form. 

 

2.10 Charts/graphs 

Charts/graphs are graphics or pictures that represent values and their relationships. A 

chart helps the reader to quickly see trends in data and to be able to compare and contrast 

aspects of data that would otherwise have remained obscure. Microsoft Excel has both 

two-dimensional and 3-dimensional charts that can be used instead of the raw data in the 

table that has to- be studied for a long time to understand it. 

 

The various types of charts available include column, bar, line. Pie, bubble and area 

charts among others. Consider carefully the type of chart that would best represent the 

base data in the worksheet before creating one. For example, if the aim is to depict the 

performance index of a student from Form I-to 3, a line chart would be most appropriate 

because it clearly shows the trend in performance. 

 

 Types of charts 

1. Line chart - represents data as lines with markers at each data value in the x-y plane. 

2. Column chart- represents data as a cluster of columns comparing values across 

categories. . 

3. Bar chart - data values arranged horizontally as clustered bars. Compares values across 

categories. 

4. Pie chart - it displays the contribution of each value to a grand total. 

5. Scatter chart - compares pairs of values on the same axis. 

  To view types of charts, right click the chart object then select the chart type command. 

 

Creating a chart 

A chart must be based on values that are already entered in the worksheet. 

 

To create a chart: 

1. Select the range of values for which you want to create a chart. 
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2. Click the Chart wizard button on the standard toolbar and the chart wizard dialog box 

will open as shown in Figure 2.25 

3. Click the type of chart you wish to .create. If the office assistant appears, close it. The 

chart sub-type preview will show several styles of the selected chart type. 

4. Click the Next button to move to the dialog in Figure 2.26.  

5. Click the Series tab then the collapse dialog button on the labels text box. 

This will shrink the dialog box so that only the category labels text box is shown. 

Highlight the data labels from the worksheet. 

 6. Click the Expand dialog button to bring the full dialog box into view then click the: 

Next button. In step 3 of the wizard, use the appropriate tabs to type the title of the chart, 

show a legend, select whether to display gridlines or not etc. After all these click the Next 

button.' 

7. At step 4 determine whether the chart will be inserted in the current  worksheet or a 

new worksheet then click Finish button (Figure 2.27). 

 

Moving and resizing a chart 

Once the chart is created, its size and location can be changed in the worksheet. The chart 

element is enclosed inside a boundary called the chart area and hence both can be resized 

independently. Simply click the object you wish to resize and use the object handles just 

like in objects to drag to size. To move the chart, click inside the chart area then drag to 

the desired position. 

 

Data ranges 

A data range is a rectangular block of cells that provides the base data that is used to 

create the chart. In charting, a data range is referenced as an absolute range e.g. . 

=Sheetl !$B$2:$C$8 which means that the base data is found on Worksheet 1 and 

absolute range B2:C8. 

To see the data range of a chart, right click it then select the Source data command. . 

 

Labels 

Each representation of data on a chart can either be labelled by a value 

or text label. For example, in a bar chart that compares the height of pupils, each bar can 

be given a value label to make it more readable. 

 

To label: 

1. Right click the chart then select the Chart options command from 

the shortcut menu. 

 

2. Click the lables tab and choose whether you want value or text labels  then click OK 

button to apply. . 

 

Headings and titles 

Each chart must have a heading showing clearly what it represents. To I make the chart 

understandable, include axis titles. 
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. To include axis titles proceed as follows: 

1. Right click the chart then select the. Chart options command. 

2. Click the Titles tab then type the chart title (heading). And axis titles respectively. 

3. Click OK button to apply. 

 

Legends 

The legend is like a key that explains what each colour or pattern of the data 

representation in the chart means. For example, Microsoft Excel may give red colour to 

one data value and green to the other. Without a legend it would be difficult to know how 

to differentiate the two sets of values. 

 

 : To create a legend: 

.1.Right click the chart then select the Chart options command. 

2. Click the legends tab and specify that it be displayed in the chart area. 

3. Click OK button to apply. 

 

2.11 

 

Printing worksheets 

A worksheet will finally be printed for sharing with others or for filing purposes. If it 

contains objects like charts, it may not fit on a standard printing page using the default 

printing options and settings. Therefore, Microsoft Excel allows the user to preview and 

set up the pages of a' worksheet in order to fit them on the hard copy page. 

 

Page setup 

1. Click .File menu option then Page setup command to display the page setup dialog 

box. . . 

2. On the Page tab, select the orientation of the page. Study the meanings of each buttons 

and options in Figures 2.28. 

 3. After making the necessary selections, click OK to apply. 

 

Print preview 

It displays the worksheet from the point of view of the printer i.e. exactly the way it will 

look when printed. Before using this command, make I sure the chart is deselected. 

1. Click the Print preview button on the standard toolbar. 

2. The worksheet will be displayed in the print preview window with the status bar 

reading preview. 

3. Click Setup to start the page setup dialog box. To close the preview, click the Close. 

Button. 

I Print options 

 

To print click File then Print command. The print dialog, box appears as shown in Figure 

2.29 . 



 45 

1. Select printer - the name box in this dialog box enables a person to select the printer 

that will be used to print the document. All the printers that are installed on the computer 

will be available here. 

2. The print what options are: 

(a) Selection - this prints the selected worksheet area.  

(b) Workbook - prints all the worksheets in the workbook.  

(c) Selected chart - prints the selected chart only. 

 

Page orientation 

As explained earlier, page orientation refers to the layout of the text on the page. A 

worksheet can also be printed on either landscape or portrait depending on the number of 

columns across the worksheet. 

 

Pages and copies . 

The number of copies box specifies how many copies of a particular worksheet or 

workbook should be printed. 

 

Sometimes only some specified pages in a workbook are specified for printing e.g. if a 

workbook has 100 pages and you wish to print only pages 50 to 60 select the page(s) 

range button then type 50 and 60 in the from, to boxes respectively before clicking the 

OK button. 

 

Printing 

After selecting all the options, click the OK button to print. 

 

Some common printing problems 

1. A message appears on the screen saying that the printer specified could not be found in 

the directory. 

 

Possible problems and solutions 

(a) The printer could be off. Switch it on and it will start printing. 

(b) The data cable to the printer could be loose. Make sure it is firm at the ports. 

(c) The wrong printer could have been selected. Select the right one in the print dialog 

box and send the print job again. 

(d) A message appears on the screen reading that there is paper jam. I 

 

The printer is clogged with a paper jam. Alert the lab, technician or the Teacher to clear 

the paper jam. 
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DATABASES 

 

Chapter outline 

 

3.1 Introduction to databases 

3.2 Database concepts 

3.3 Data organization in a database 

3.4 Creating a database using Microsoft Access  

3.5 Editing a database 

3.6 Form design 

3. 7 searching for specific records in a database  

3.8 Creating reports 

3.9 Creating labels 

 

Introduction to databases 

We are often faced with the need to keep, search for or give a report of daily experiences. 

This is the reason why many people use data storage methods like recording daily 

experiences in a diary. Traditionally, human beings used to manage data and information 

manually by using simple devices. However these methods have a number of weaknesses 

which include 

 

1. Unnecessary duplication of data 

2. Boredom and time wasting especially when searching for a Particular item. 

3. Misleading reports due to poor data entry and organisation 

4. Poor update of records etc. 

 

Today, computerized systems have radically changec4the way data and information is 

managed by use of special programs called Database Management System (DBMS). 

 

A database is a collection of structured and related data items organised so as to provide 

a consistent and controlled access to the items. 

 

Database concepts . 

Computerised database creation and manipulation is achieved using Database 

Management System software. This software facilitates the creation, organisation and 

maintenance of databases. Examples of database management software’s include 

Microsoft Access (Ms Access), Oracle, FoxPro, Dbase/V, Lotus Approach etc. 

 

The functions of database management software are to:  

1. Allow the user add or delete records. 

2. Update or modify existing records. 

3. Organise data for easy access, retrieval and manipulation of records.  

4. Act as an interface between a database and other application programs.  

5. Ensure security for the data in the database by safeguarding it against unauthorized 

access and corruption (damage). 

6. Keep statistics of data items in a database. 
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Database models 

 

Databases are classified according to the method used to organise data. The main 

database models are; 

1. Flat file 2. Hierarchical 

3. Network    4. Relational 

 

NB: Current database models are called object relational and object databases. However 

these models will not be discussed in details in this book. 

 

Flat files 

 

In a flat file model, a database holds only one set of data and is not any different from the 

manual files. For example, the teacher's assessment report may consist of performance 

cards for every student in a class. Another example of a flat file database are the cards 

used in a library books catalogue. The cards are arranged sequentially for easy access e.g. 

alphabetically using books' titles or by authors' names. Figure 3.1 below is a sample 

record of a flat file. 

Name Serah Seki 

Admission number 649 

Total marks 680 

Number of subjects 10 

Average 68 

Position 4 

Fig. 3.1: Sample record in a flat file 

 

Hierarchical model 

 

In this model, data items are arranged in hierarchical (tree) form as shown in Figure 3.2. 

To access level two data items, you have to first access level 1 data items. Level 1 item is 

called the root component. A specific single path leads to each item at lower levels. 

Hierarchical model is rarely used in modem database systems. 

 

                 Level 1 main data item 

                                 Path 

               Level 2 data item 

 

 

Fig. 3.2: Hierarchical database model 

 

Network model 

 

In this type of organisation, links are used to express the relationship between different 

data items, forming a network of items as shown in Figure 3.3. Access to one item can be 

through multiple paths and from any item. This model is also rarely used in modem 

database systems. 
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Fig 3.3: Network database model 

 

Relational model 

This is the most common type of model used on minicomputers and microcomputers. In 

this type of organisation, related data items are stored together in structures called 

relations or tables. Relationship can be created between tables such that a record or 

records from one table relates to another or other records in another table. Tables 3.1 and 

3.2 show customers and orders tables that are related by two fields; the customer number 

in Table 3.1 and customer ID in Table 3.2. In this case, the orders table shows that one 

customer with number 450 (Bat Hori) has made several orders. 

 

  Customer Number Name  Telephone number 

  900  Mary Koech 02078907 

  230  Peter Karimi 0667896 

  450  Bat Hori 04456000 

   Table 3.1: Customer number  

 Customer ID Order Number Date   Amount (sh) 

 900  2380  2/3/2004 90 000 

 450  811  2/5/2004 5000 

'- 450  234  . 3/5/2004 13 000 

 450  567  3/6/2004 13 000 

Table 3.2: Customer ID 

 

Object oriented models . ! 

The next generation of database model will look at records as objects that are 

independent and relate with the other objects in the database. This concept is a bit 

difficult to conceptualise because such databases are still at developmental stage. 

However, many databases today combine object and relational concepts to come up with 

object relation models. 

 

Features of a database management software 

Most database software contains a collection of features that provides the user with a 

means to manipulate data in a database. These features include Tables/files, Queries, 

Reports generators, Form interface and a computer programming language within it. 

Microsoft Access database software that will be considered in this book has two distinct 

features used to automate operations namely Macros and Modules. 

 

Tables/ file structure 

This is a database structure that is used to hold related records. Tables are organised in 

rows and columns with each row representing a record while each column represents 

Data item 2 
Dataitem 1 

 

Dataitem 3 

 

Dataitem 4  

 



 49 

common fields in each record. Table 3.3 shows a table of six records and each record is 

made up of four fields. 

 

FIRST NAME MIDDLE 

NAME 

LAST NAME ADDRESS 

MBUGUA STEPHEN KIMANI 250 KERUGOYA 

ADERA NELSON ODUOR 396 HOMA BAY 

MARGARET JUDY WEKESA . 761 NAIROBI 

GATO PATRICIA MUILA 170 TALA 

MWELU LUCY. MWENI 390 KANGUNDO . 

KOECH PETER KORIR 605 KERICHO 

 

Table 3.3: Table of six records and four fields 

 

Queries and query language 

 

A query is a database tool used to search for or question a database on specific records. 

Because a query is a question posed to the database, it returns a result for the user. In 

Microsoft Access, this result is called a dynaset. For example, assume you work with the 

National Irrigation Board (NIB), you may wish to display all those farmers from Mwea 

Rice Irrigation Scheme who delivered rice in January to the National Irrigation Board. 

You can use a query object or statements to get the required records. 

The query statements are written using a special language called  

Structured Query Language (SQL). The user creates a, query by writing Structure query 

language statements such as:  

Select  

Farmer Number, Name, Month of Delivery 

From 

 Delivery Table 

Where 

Month of Delivery = "January" 

 

Forms/screen input 

 

A form is a graphical interface that resembles the ordinary paper forms used to collect 

data. However, a database form enables the user to view and enter data into a table. 

Figure 3.4 shows a sample form used for entering a student's marks scored in four 

subjects and. the date of admission. Form interface is a more convenient and easy way of 

entering and viewing records from a table. 

 

Reports 

 

Most database systems provide the user with a tool for generating reports from an 

underlying table or query. It is the report generator that provides the user with a means to 

specify the output layout and what is to be output or printed on a report. Table 3.4 shows 

a sample report for employees' salaries. 
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Net Pay Report 

 

fay rol/no .Last.Name      First Name. . .Basic salary                PAYE              Net salary. 

 

07 Wangui Grace sh 80,000.00 Kshs 7,300.00 sh 72,700.00 

09 Ochieng Mbenga sh 37,000.00 Kshs 3,800.00 sh 33,200.00 

13 Mumbua Peter sh 22,000.00 Kshs 2,300.00 sh 19,700.00 

20 Mbuvai Sicily sh 60,000.00 Kshs 5,700.00 sh 54,300.00 

  Table 3.4: Sample report   

 

Macros 

 

Some database software provides the user with a tool called a macro, that can be used to 

automate frequently performed procedures or tasks. For example, if you frequently use a 

particular form when you start a database program, you need to create a macro that 

automates the opening of the form. 

 

Programming module 

 

When your database becomes more and more complex, you may need a more powerful 

tool than the macros to automate your database operations further. Some database 

software come with their own computer languages associated with them. For example 

Microsoft Access comes with a language called Visual Basic included as a Module in the 

software. Using this feature, you can create a program that will print a query result over 

and over again until a certain condition is true. This can be illustrated using a simple 

statement like; 

 

Print Student Report until NumberofStudents = 40 (Not a real command anyway). 

 

NB: For the purpose of this book, only tables, forms, queries and reports, have been 

covered. 

 

Data organisation in a database 

One of the functions of a database system is to organise data for easy access, retrieval and 

manipulation. Data is organised from the simplest fQfll1 called a field to a very complex 

structure called a data,base. 

 

Fields 

A field is a character or a logical combination of characters that represent data item. For 

example, in a class list, the student name is a field. 

 

Records 

This is a collection of related fields that represent a single entity. An example of a record 

is the student report card that may contain the. student's name, admission number, class, 

total marks, average and grade. 
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Files/tables 

A file is a collection of related records. For example, the students' file in a school 

database contains the details of all the students in the school. 

 

Database 

This is the highest in data organisation hierarchy that holds all related files 'or tables. For 

example, a school database may contain students and staff tables/files. 

 

Creating a database using Microsoft Access 

Microsoft Access (Ms Access) is a package in Microsoft Office suite used for creating 

and manipulating databases. Because there are different versions of Ms Access such as 

Ms Access 95/97/2000 and XP, a general approach for carrying out tasks has been 

adopted in this book. However most of the illustrations are based on Access 2000 in order 

to maintain consistency. 

 

Starting Microsoft Access 

1. From Windows desktop, click the start button. 

2. Select. Microsoft Access from the programs menu 

3. In the dialog box that appears when Microsoft Access starts, click Blank Access 

database as shown in Figure 3.5 then OK. 

 

4. The Save As dialog box appears. See Figure 3.6. This lets you specify the name and 

location where your database will be stored. Click Create to save the database. 

 

5. Microsoft Access database objects window is displayed from which I you can choose the 

type of object to create such as tables, forms, queries etc. 

 

Microsoft Access screen layout 

Like the other applications discussed earlier, Ms Access application Window has a title 

bar, menu bar, toolbars and status bar. However instead of having a work area like that 

ofMs Word or Excel, it provides the user with an object window from which you choose 

the type of an objectto work with such as tables, forms, reports e,tc. See Figure 3.7. 

 

 .Exiting from Microsoft Access 

Because Microsoft Access consumes a large amount of computer memory  it is advisable 

to exit from the application at end of each working session. 

 

To exit: 

From the File menu, click exit the close button on the title bar. 

 

Guideline on designing a good databases 

To design a good database which will require little time to maintain, consider the 

following: 

1. Carefully study the requirements of the user in order to define all the data inputs, 

outputs and relationships required. 
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2. Design a draft database on the paper to determine the number of files or tables 

required. 

3. Divide the information into separate fields, records and tables to allow flexibility in 

manipulating the database. This process of dividing information into independent tables 

to avoid repetition of data entries items is referred to as normalizing a database. 

 5. Define a field for each table that will be used to identify each record uniquely. This 

field is referred to as a primary key 

6. Give the most important fields the first priority when constructing a table structure. 

Important fields are those that are used in sorting' and querying the database. " 

7. Design data entry forms needed for the database 

Creating a table/file structure 

To define a table structure: 

1. From the Microsoft Access objects window, click the tables tab then new 

2. From New table dialog box, select Design View Figure 3.8 appears. : 

3. using the grid displayed, enter a unique name for each field in the table. A field name 

must start with a letter and can be up to a maximum of 64 characters including letters, 

numbers, spaces and punctuation. 

4. Choose the correct data type before adding the next field. By default, Ms Access 

inserts Text as a data type. Figure 3.8 shows various data types used in Ms Access. 

6. To save the table, click the Save button on the standard tool bar or save from the file 

menu. 

7. Access will ask you whether you want to create a Primary Key, click Yes. 

 

Description of field data types 

The type of data to be used in a database must be clearly defined for the purpose of 

manipulation and storage. For example, if a field is to be used for calculation, it must be 

defined as a number. The data types allowed in Ms Access include: 

 

Text 

This type includes alphabetic letters, numbers, spaces and punctuation. Use this data type 

for fields that do not need to be used for calculations such as names, places, identification 

numbers etc. This type of field accommodates a maximum of 255 characters. 

 

Number 

These are fields made up of numeric numbers 0 to 9 that are to be manipulated 

mathematically. 

 

Memo 

This is a field made up of alphanumeric (both alphabetic and numeric) data. Instead of 

using Text use this data type if you need to enter several paragraphs of text because it 

accommodates a maximum of 32 000 characters. 

 

Date/Time 

Used to identify a field as either a date or time. This is because date/time values can be 

manipulated mathematically in a database. For example, you can calculate the age of a 

person from the date of birth to the current data. 
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Currency 

Used to identify numeric values that have decimals or fractions. Use this data type 

especially when dealing with monetary values such as fees balance, amount sold etc. 

 

AutoNumber 

This is a numeric value used if you wish Ms Access to automatically increment the 

values in a field. For example when entering a list of forty students and you have a field 

labelled StudNumber, the numbers will increase by one every time you enter a new 

record. 

 

Yes/No 

 This is a logical field where an entry is either a yes or a no, true or a 

false. For example a field may require you to answer whether you are a male or a female. 

 

OLE Object 

OLE stands for Object linking and Embedding. This type of field is mostly used with 

graphical user interface applications for inserting graphical objects such as pictures, 

drawings charts etc. - - -- 

 

Field properties 

As you create more and more complex tables, you will find a need to use the field 

properties to specify finer details related to fields and the table entries expected. The field 

properties depend on the type of-the field selected. For example when you click on a Text 

field then the General tab you will see properties associated to text data type as shown in 

Figure 3.9. The various properties are: 

 

Field size 

This allows the user set the number of characters in a field instead of the default 50 for 

text fields for numeric field’s integer and long integer, Byte, Single and Double. 

Integer and longer integer: Accept numbers with no decimals. 

Byte: Can only accept a number from 0-255. 

Single and double: Accept numbers with decimals. Single accommodates up to 38 

decimal places while double, accommodates up to 308. 

 

Format 

Determines how information appears on the screen and when printed. For example, you 

can format a number to scientific, currency, percentage or general format. 

 

Decimal places 

For number and currency fields you can specify the number of decimal places. 

Input mask , 

Input mask automatically formats the field entry into a specified format. F or example, if 

you enter a number such as 02000 I 00409874 and the input mask is set as 000-(00000)-

000000, it is automatically displayed as 020-(00100)-409874. This property is mostly 

used to format phone and address entries. 
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Caption 

This is a more descriptive name for a field to be used in a table or a form display. For 

example the caption for StuName could be Student Name. 

 

Default value , 

This is a value that will appear automatically in the datasheet or form if ' nothing is 

entered by the user to change it. For example = Date -( ) automatically displays the 

current date in a date field. 

 Validation Rule 

Logical expression restricts the values to be entered in a field. 'For example, if you want 

to restrict marks entered in a field to values between 

, zero and a hundred, type >=0 And <= 100. 

 

Validation Text 

The message that appears once the validation rule is violated. For example, you may 

create a validation text for the above validation rule I to display "Enter a number between 

0 and 100" whenever the user enters I a value outside this range. 

 

Required 

Determines if an entry must be made in the field before you proceed to the next field or 

record. For example, if a primary key is required, you must enter before you proceed. 

 

Allow Zero Length  

This allows the user to proceed without making any entry in the field set as Zero length. 

 

Indexed 

An Index, facilitates the organisation of records for easy search. A primary key is an 

example of an index set to No duplicates to control double entry of a record 

(redundancy). 

 

Primary key and Indexes 

 

An index is a database feature used to speed up search and sort operations in a table. A 

key field also referred to as a primary key is a special index that enforces uniqueness in a 

table so that one record is not entered twice. 

 

Ms Access uses the primary key to search for data stored in a table as well as define 

relationships between tables. Once a field is set as primary key, its datasheet is 

automatically indexed or sorted using the primary key. 

To set a primary key: 

1. Open the table in design view. 

2. Select the field you want to set as the primary key by clicking in the row header to the 

left of the Field Name. 

3. Click Set Primary key button on the tools bar. A key should appear on the left of the 

field name as shown in Figure 3.10. 
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To see another field as an index other than the primary key: 1. Open the table in design 

view. 

2. Ensure that non of the fields is selected as a primary key. 

3. Click the Indexes button on the tool bar that is located next to the primary key. The 

index design grid is displayed on the screen as shown in Figure 3.11. 

4. In the index name column, type in the name you want to give to  the index. 

 5. In the Field Name column, click the cell to display a drop down list. From the drop 

down list, select the field to use as an index. 

6 In the Sort Order column, select either ascending or descending.  

7. In the lower portion, specify whether you want to make the field a primary key by 

selecting yes for primary and unique, and Ignore Nulls to ensure that data is entered into 

the field before proceeding. 

8. Close the dialog box. 

 

Entering data into a table 

 

To enter/append data into a table: 

1. Open the database in which the table is located 

2. Click the Tables tab then double click the table you want to add records to. 

3. Enter each record field by pressing the tab key to move to the next. Once you reach the 

end of the record and move the cursor to a new row the previous record is automatically 

saved. 

 

Editing a database 

 

Modifying the Datasheet view  

 

To adjust the column size: 

1. Point to the column border between the field's header then drag to the require size. 

2. Alternatively, click on the format menu then point to column and click on width 

3. Type the desired width 

To adjust row height 

1. Point to the border between two rows in the row header and then drag. 

2. Alternatively, use format menu, then Row height. 

To reorder fields: 

1. Select the column of the field you wish to move by pointing to the desired file name. 

2. Drag the column right or left to the top of the field where you want your field to appear 

and then drop. 

 

Modifying the table structure 

 

Once you create a table, you may need to add more fields, remove some fields, reorder 

the fields or change fields data types and properties. Before you modify the table it is 

important to save a copy to avoid losing everything in case you make a mistake 

To make a copy of your table:  
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1. From the file menu, click save as /export 

2. From the dialog box that appears, choose whether to save to another (external) 

database or the current. 

3. Type a new name for your table and click OK. 

 To modify the original table: 

1. Open the table in design view by clicking the button that looks like a pencil and a set 

square placed on the edge of a ruler. 

2. Select the field or fields to be modified and make the necessary changes.  

3. Click the Save button to save the changes. 

NB: If a table contains data and you make changes to the field data type, Ms Access may 

refuse to implement the changes. To avoid this problem, exit without saving and delete 

all the records from the table then return to the design view. You can then import a copy 

or copies of tables you backed up. 

To import a table from another database: 

1. From the File menu, point to Get External Data then click Import 

 2. From the dialog box that appears, select the database you wish to 

import data from then click the Import button. Objects dialog box is displayed as shown 

in Figure 3.12. 

3. From the objects dialog box displayed, click the Tables tab  

4. Select the table(s) you wish to import then click OK. 

 

Form design 

 

Tables display many records at once from the database and in some cases you may not be 

able to see some fields properly. A form is an interface that enables the user to view and 

make data entries into an underlying table more easily. Figure 3.13 shows a sample form 

used to enter records into a books table. 

 

In Microsoft Access, a form is designed using graphical objects called controls. A control 

is an object such as a text box, check box, command button or shapes that you place on a 

form design grid to display data or perform actions. There are two types of controls you 

can place on the grid: bound and unbound controls. A bound control is one whose source 

of data is a field in a table or query while unbound control is a control that is not 

connected to any data source. 

 

You design or modify a form layout by dragging these controls to the required position. 

Figure 3.14 shows a form layout grid for a table called exam entry. 

 

 Creating a form layout using form wizard 

 

To create a form layout, you can either use the form wizard or start from scratch. Using 

the form wizard you can create either a columnar, a tabular a datasheet or a justified form 

layout. 

Columnar form: The fields for each record are displayed down a column i.e. each value 

displays on a separate line with field labels to the left. Tabular: Records are displayed 
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from left to right across the page and labels appear at the top of each column and each 

row represents a new record. 

Datasheet: The form resembles a table datasheet view. 

Justified: One record occupies the whole form. 

To create a form using the form wizard: 

1. Open the database for which the form is to be created e.g."EMPLOYEES" 

2. Click the Form tab then, New. From the New form dialog box that appears, click Form 

Wizard. 

3. Select the table you want to create a form for then New, A dialog box appears. 

4. Click the name of the table or query that includes the data you want to add into the 

form, and then click OK. 

5. From the fields list window, select the fields to add into the form by clicking the> 

button or click>> to add all fields then 

6. From the layout dialog box, select the layout you wish to use e.g. Standard then. click 

Next. 

7. In the Form title dialog box, type the name of the form then click Finish. Ms Access 

will automatically display the form on the screen. 

 

Creating a form using autoform wizard 

 

You can easily create a form using the Autoform wizard. This wizard creates a form for 

you automatically by asking you very minimal questions. The form includes all the fields 

from the selected table. 

 

To construct an autoform tabular. 

1. Make sure your database is open 

2. Click the Form tab, then New. 

3. In the new form dialog box, select an auto form layout e.g. columnar  

4. In the "Choose the table or query where the object data comes" select the table you 

wish to create a form for then click OK. The form with all fields will be displayed. 

5. Click the Save button to save the form. 

 

Creating a form from scratch 

 

1. Open your database 

2. In the database window, click the Form tab then New 

3. From the New form dialog box, select Design view 

4. In the "Choose the table or query where the-object data comes" select the table you 

wish to create a form for then click The form with all fields will be displayed. 

To add controls onto the grid: 

1. Click the View menu, then. Field list command . The table you selected fields list is 

displayed. 

2. Drag and drop each field and arrange them on the grid. 

3. Save the form by clicking on the save button. 
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Data manipulating in a form 

 

Adding and displaying records 

 

The form provides the user with navigation buttons located at the bottom that can be used 

to navigate the form  

The functions of the buttons can be summarized from left to right as follows 

1. Displays the first record in the table 

2. Displays the previous record.  

3. Displays the next record 

4. Displays the last record. 

5. Add a new record. 

 

Formatting fields/controls in a form  

To format fields in a form; 

1. Open the form in design view 

2. To resize, click the controls then position the pointer on the outline of the control then 

drag to the required size. 

3. To move, click the control and position the pointer onto the place holder or inside the 

control then drag to the required location. 

 

Searching for specific records in a database 

One major reason for use of a computerised database is the ability to search and retrieve 

specific information more efficiently. Rather than searching through endless filing 

cabinets, you simply enter an instruction and let the database do the rest. To search for 

data in a database, Ms Access provides the user with two search tools: 

1. Find command 2. Queries' 

 

Using the find command 

With a large database, the Find command saves your time when you need to move a 

record pointer to a particular record. 

To search for a record: 

1. From Edit menu, click Find. The find dialog box appears in which you specify the field 

you want to search for in the" Find What" box as shown in Figure 3.16. 

2. Type the name of field you wish to search for in the Find What text  box. . 

3. In the Search box (Figure 3.16), specify whether to: 

( a) Search All 

(b) Search Down to up or 

(c) Search up to bottom 

4. In the match box, you can select one of the match types: 

(a) Any part of field - As long as a string of characters to be searched are present in a 

word, then all the words having the string will 

be searched e.g. "Berg" finds Berger, inselberg etc. 

(b) Whole Field - Searches for the whole field for example, "Berg" 

will not return Berger, inselberg but specifically berg if it is in the database. 
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(c) Start of Field - Specifies that, the searched word should start with the specified search 

string e.g. "Berg" 

5. In searching, you can also check or uncheck; 

(a) Match case - Finds only text that has the same pattern of upper and lower case as the 

one specified in the Find What box. 

(b) Search Field As Formatted - Select (check) to find data based on its display format 

e.g. 'a date stored asa number 1/5/98 but 

displayed as 05-Jan-98 

(c) Search Only Current Field:- Select to search through all records for the current field 

only.  

6. After you set the search conditions click the Find First button.  

7. If you want to search for the second record or other records with the same field, click 

Find Next button. 

 

You can use a wildcard e.g. asterisks (*) if you are not sure of the correct search word 

that will find all records that match the specified search string. For example, if you wish 

to search for all names that start with letter "J" in a school database, type J *. All names 

that start with J e.g. John, Jane Joy, Joyce and James will be displayed. 

 

Using Queries 

Queries are the fastest way to search for information in a database. A query is a database 

feature that enables the user to display specific records as well as perform calculations on 

fields from one or multiple tables. You can analyse a table or tables by using either a 

select query or an action query. However, only the select queries will be discussed in 

detail in this book 

 

Select query 

This is the most common type query used for searching and analysing data in one or more 

tables. Select query lets the user specify the search criteria and the records that meet those 

criteria are displayed in a dynaset 

 

Action query 

These are queries that are used to make changes to many records once. They are mostly 

used to delete, update, add a group of records from one table to another or create a new 

table from another table. 

 

The four types of a action queries found in Microsoft Access are: 

1. Update - Updates data in a table. 

2. Append query - adds data in a table from one or more tables. 

3. Make table Query - Creates a new table from a dynaset. 

4. Delete Query - Deletes specified records from one or more tables. 

 

Creating a select query 

1. Ensure that the database you want to create a query for is open.  

2. Click the Query tab, then New. 
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3. From the New query dialog box, choose either to create a query from in Design view or 

using a Wizard. 

4. To design from scratch, click Design View. The Show Table dialog box appears from 

which you can add a table or tables you wish to create a query for as shown in Figure 

3.17.  

5. Click the table from the table/ query list and then click Add.'  

6. Click Close to close the show table dialog box. 

7. The query design grid opens. In Microsoft Access it is called Query By-Example. This 

lets the user to design a query. Figure 3.18 is QBE grid for a table called Exam. 

 

Parts of the query grid  

Field row- Fields from a table or tables to be used are arranged in this row. Each field 

should occupy its column. 

Sort row - By clicking the down arrow in the sort cell, you can specify the sort order i.e. 

ascending, descending or no sort. 

Show row - By clicking the Show box, you specify whether to display the field in the 

query results: When the box is not checked, the field will not be displayed. 

Criteria row - This is where you type conditional statement that will be used by the query 

to display specific records. 

Or row - Used to specify an alternative condition e.g. if you want to display records with 

a field called City with items Nairobi or Embu, type Nairobi in criteria cell and Embu in 

the Or cell. 

To add fields into the query grid: 

1. Open the query in design view 

2. From the field list of the underlying table, drag each field and place it in the field row 

 

Specifying the search criteria 

In order to search for a particular set of records, you have to enter a conditional statement 

or statements in the criteria row. For example if you have a table called employees with 

one of the fields as salary, you can display all the employees earning more than Shs. 

5,000, by typing >5000 in the criteria row, salary column. 

 

To define criteria, use either relational or logical operators. Relational operators include 

less than «), greater than (», greater than or equal to (>=), less than or equal to «=), not 

equal to «» and equal to (=). Logical operators include AND, OR and NOT. 

 

Use AND to display values in a specific range. For example, to display records from the 

employees table with salaries above 4000 but less than 6000, type, >4000 AND < 6000 

on the criteria row in the salary column. All the employees who meet this condition will 

be displayed. 

 

Use OR if you wish to get either one of two values. For example if you wish to get those 

employees either in Nairobi OR Embu. 

 

If you want to display data in a particular range use the word Between. For example, 

instead of typing , >4000 AND < 6000, type Between 4000 And 6000. 
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If you want to list all records except those that you do not want to see use NOT. For 

example if you type NOT 6000 in the salary column of the employees table, all 

employees records will be displayed except. those with their salary as 6000. 

 

To display records you are not sure of the field name but at least you can remember a few 

characters, use LIKE and the wildcards. Wildcards are 

special symbols mostly an asterisk and a question mark used in place of other characters. 

For example, to display all names starting with "Sm" followed by any other character, 

type Like Sm? Like */*/1993 lists records created in 1993 regardless of the day or month. 

 

Saving and running the query 

1. Click the Save button on the standard tool bar or save command from the file menu. 

2. In the name box that appears, type in the name of the query then click OK. 

3. To run the query in design view, click the Run button on the toolbar as shown in 

Figure 3.19 or Run command from the Query menu. 

4. You can view the results of your query any other time by selecting the query, then 

clicking the Open button from the database window. 

 

Sorting the dynaset To sort a dynaset: 

1. In the sort row, click the down arrow that appears to specify the sort order i.e. 

ascending or descending of the desired field.  

2. Display the dynaset. 

 

Modifying and updating a query 

To delete fields from the query grid: 

1. Open the desired Query in design view.  

2. Select the field column you wish to delete  

3. Choose Delete from the Edit menu. 

4. Click the Save button to save the changes 

 

To adjust the column size in a query 

1. Open the desired query in design view. 

2. Position the mouse pointer at the boundary that separates columns then drag it to the 

required size. Alternatively, double click the boundary to auto fit cell content. 

3. Click the Save button to save the changes 

To modify a criteria statement 'select query, 

1. Open the desired query in design view. 

2. Modify the criteria statements as desired, 3. Click the Save button to save changes. 

4. To test whether the changes have been effected, click the Run button to display the 

results of the query. 

 

Performing calculations in a query 

Unlike tables, queries let the user perform mathematical calculations on numeric data. 

You can perform calculations in a query by using the Total functions or by creating basic 

formulas 
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Creating basic formulae 

To create a formula that calculates the total marks in an underlying table e.g. Exams 

table: 

1. Open your query in design view 

2. In an empty cell, preferably the immediate last field cell, type an expression that 

includes a field name of your choice such as: 

Total: [Math’s) + (Physics) + (Chemistry) as shown in Figure 3.20 

 

Math’s Physics Chemistry Total: 

(Math’s)+(physics)+(Che

mistry) 

Exam Exam Exam  

   . 

        √      √     √     √ 

 

Fig. 3.20: Creating an arithmetic expression 

 

3. You can then set the criteria, and other query options. 

4. Save the query and run it. The results of the calculations will be displayed in the 

dynaset as shown in Figure 3.21. However, this field is not added to the underlying 

table(s) because query results must always be based on the most current data in the 

database.  

Using Total functions . 

With a query, you can analyze all records fields using the inbuilt functions such as Sum, 

Average, Minimum and Maximum etc. To use the total functions: 

1. Open your query in design view. 

2. Click the Totals button on the query toolbar. 

3. Select the field you want to analyze. 

4. For each field to be analyzed, click its cell in the Total row, and then select any of the 

functions as shown in Figure 3.22.  

Sum: Adds all the numerical data items. 

Avg; Calculates the mean of all numeric data items in the field column.  

Min: Returns the minimum value from the field column. 

Max: Returns the maximum value from the field column. 

Count: Returns the number of items field column. 

5. Set criteria and other options then click run to preview the results 

6. Save the query. 

 

Printing a query: 

1. Open the database window of the database containing the query you want to print 

2. Click the query tab then the query you want to print. 

3. From the file menu, click print Set the printing options then click the OK. Button. 

 

Creating a select query from multiple tables 

When you use fields from more than one table in a query, there should be a common link 

or relationship between the tables. There are three type of relationships  
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1. One – to - One 

2. One -to - Many 

3. Many -to - Many 

In a one -to - one relationship, for a particular field in one table (the main table), there is 

only one matching record in the related table and vice versa. In a one -to - many 

relationships, for a particular field in one table there are several matching records in 

another table. This is the most common type of relationship. For example, a person may 

make one order, or several orders. For this instance, there is only one record with that 

person's details say in customers' table, yet there are several records related to the same 

person in the Orders table. 

In a many -to - many relationship, for particular records in one table there are several 

matching records in the other table and vice versa. This is not very common. 

 

Defining relationship between tables 

1. Make sure your database is open. 

2. From Tools menu, choose Relationships. The relationship dialog box appears. 

3. Select the tables to add then click the Add button. . 

5. To create relationship, click on the common field and drag it to the second table. The 

fields used to create the relationship must be of the same type and properties. 

6. To Enforce Referential Integrity, right click the line joining the two tables then click Edit. 

An Edit relationship dialog box such the one in Figure 3.23 will be displayed. 

7. Make sure Enforce Referential Integrity is checked to ensure that all records entered in the 

related table exists in the primary table. 

 

8. Click OK to close the Edit relationship dialog box. 

 

To create a query based on related tables 

1. Start the database window and click the Queries tab,  

2. Select design view and click OK. 

3. From the show table dialog box, click the tables you want to base your query on and 

then click Add. 

4. Relationship between various tables will be displayed as shown in Figure 3.24. Add 

the fields from both tables into the QBE grid. 

5. Save and Run the query. 

 

Creating reports 

Reports are used to summarize and present information from a database. A good database 

software should enable the user to generate database reports and print them for 

presentation and distribution. This process is referred to as formal presentations. As with 

forms, a report layout is also designed by placing controls on to the report layout grid as 

shown in Figure 3.25. 

 

Parts of a report layout in design view 

Report Header-This contains unbound controls that displays title of the report. 

Page Header - Contains heading or labels data items to be displayed in every column. 
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Detail - Holds bound controls that display data items for the table or query it was created 

from. 

Page footer holds a control that is to be displayed on every page such as the page number 

and date. For example =Now() displays the current date and time as set in the system 

clock. 

 Report footer - Used to display summary from a report such as the grand total for 

numerical data in a particular field column. 

 

Creating a report using report wizard 

Just like the form wizard, report wizard takes the user through a number of steps by 

answering a few questions and Ms Access automatically does the rest. 

 

To create a report layout: 

1. Ensure that the database is open. 

2. Click the Report tab, then New 

3. From the/New Report dialog box, click Report Wizard then 

4. Select a table or a query then the fields to be added to the report then click next. 

5. The wizard asks you whether you wish to add any group. Grouping is used to 

categorise records using a particular field for better presentation or if you need to perform 

calculations on a group of common items. For example, to categorise books in a library 

database according to ISBNNumber, double click the field then click Next. (Figure 3.26). 

6. In .the dialog box that appears, select the Sort option if you want to sort the records. 

You can also click the Summary options button in case you want Ms Access to perform 

calculations on numerical fields. In summary options dialog box, select the Summary 

options you want performed e.g. Sum, Average etc. as shown in Figure 3.27. Click OK to 

close the summary options dialog box then Next. 

8. From the layout dialog box, select the type of layout such as stepped, block etc. Select 

page orientation i.e. either portrait or landscape then click Next. 

9. In style dialog box, specify the report style by selecting either bold, casual etc. 

10. Finally enter the name of your report then click finish. The report will be displayed on 

the screen in print preview mode. 

 

Creating a report in design view 

Just like with forms, you can create a report in design view by placing controls on the 

report design grid. 

 

To design a report in design view: 

 

.' 

1. In the database window, click the Reports tab then New. 

2. In the New Report dialog box, click Design view. 

3. Click the name of the table or query you want to generate a report from. 

4. Click the OK button. You will get a report design grid where you can place data 

controls.  

5. From the view menu, click Field List.  
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6. To design the layout, drag each field from the field list to the layout grid and drop it 

where you want the data column to appear. 

7. Once you finish placing controls, click the Save button. 

8. In the save as dialog box, enter the name of the report and click OK.  

9. To view the report, click the Print Preview button. Alternatively, click Print Preview 

from the file menu. 

 

Modifying a report layout 

To modify headers and footers: 

1. Open the report in design view. 

2. Click the report header or footer you want to modify. 

3. Make the necessary changes and then click the Save button.  

4. Click the Print Preview button to view the changes. 

 

To add more controls onto the report layout:  

1. Open a report in design view. 

2. Display the field list by clicking the Field list button or using the View. 

3. Select one or more fields in the field list and drag view to the Report design grid. 

 

To resize or move a control: 

1. Click at once to select it. Position the mouse pointer to on the place holder, until the 

mouse pointer changes to a double-sided arrow. Drag the pointer to resize the control 

2. To move a control, select it and place the mouse pointer on the place holder until it 

changes to a hand. 

 

Creating labels 

A label is a sticker or piece of paper put on an item for the purpose of identification. 

Examples of stickers are mailing labels, label on the floppy disk where you write your 

name etc. Using the report label wizard, Microsoft Access lets you easily create labels of 

different sizes. 

To create a label using the report wizard, 

1. Open the your database 

2. From the database window, click the Report tab then New 

3. From the New Report dialog box, select Label Wizard the table or query from which 

the labels are to be generated from. 

4. Label wizard starts running as shown in Figure 3.28. 

5. From a series of dialog boxes displayed, specify the label size, font, and fields to be 

included in the label, whether to sort the labels, the name of the label then click Finish. 

 

Modifying labels 

Just as you can modify a report or a form, you can also modify a label by manipulating 

the layout controls. 

To modify a label, 

1. From your database window, click the Report tab then the Design View button. 



 66 

2. The label design grid is displayed. Edit the layout as desired, save and close the design 

grid. 

3. To view the modified label, click the Preview button from the database window. 

 

Printing the report and labels 

Before you print a report or a label, you should first set the page options i.e. the margins, 

paper size and orientation. 

1. Open the database that contains the report you want to print. 

2. Click the Report tab, select the report you want to print then click the Preview button. 

3. From the File menu, click Print. 

4. Set the printer options i.e. the printer type, print range and number of copies. 

5. Click OK to print. 
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DESKTOP PUBLISHING (DTP) 

 

Chapter outline 

 

4.1 Introduction. 

4.2 Definition of desktop publishing.  

4.3 Purpose of desktop publishing. 

4.4 Types of desktop publishing software.  

4.5 Designing a publication. 

4.6 Manipulating text using the toolbox  

4.7 Editing a publication. 

4.8 Formatting a publication. 

4.9 Printing a publication. 

 

Introduction 

Have you ever asked yourself how newspaper and book publishing companies manage to 

produce publications that are attractive with creative layouts and graphics in large 

volumes? They do this through a special process called publishing. Publishing is the 

process of producing publications like newspapers, cards, pamphlets, pictures, calendars 

etc. that have special text and graphical layouts and designs. The traditional method of 

publishing involved drawing and writing manually on wooden or metallic boards. The 

artwork would then be painted with ink and pressed on papers to produce a printout. This 

was a very tedious work. 

 

Today the art of publishing has changed because of the advent of personal computers and 

smaller printers that are able to print high quality text and graphics even in an office or at 

home. 

 

Definition of desktop publishing (DTP) 

Desktop publishing refers to the process of producing publications like cards, newspapers 

etc. by designing their text and graphics layout and inserting, editing, formatting and 

printing of text and graphical objects using a special desktop publishing software 

installed on computers. The term desktop means that all the publishing processes can now 

be done on a desk in the office or at home using a personal computer! The difference 

between a desktop publisher and a word processor is that a desktop publisher software 

gives the user more tools and control of the page layout, text manipulation and graphic 

design than a word processor. 

 

However it is important to note that some word processors today have also been 

incorporated with text and graphic formatting and editing tools. Hence a thin line exists 

between them and the desktop publishers. For example you can design a full publication 

in Microsoft Word by using the available drawing and picture tools, create columns etc. 

 

Examples of desktop publishers include Adobe PageMaker, CorelDraw, Microsoft 

Publisher and Ventura. This book will use Adobe PageMaker to demonstrate the 

concepts of desktop publishing. 
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Purpose of desktop publishing software 

Desktop Publishing programs are very popular in publishing because they give the person 

designing publications (typesetter) a lot of control on: 

Graphic design: Using desktop publishing software, a typesetter can create and edit very 

complex text and graphical objects like pictures to the finest details. For example, the 

software provides the user with rulers and ruler guides that can be used to place an object 

in exactly the correct position. 

Page layout design: With a desktop publisher, the user can be able to design a page 

layout by setting consistent picture and object locations, dividing a page in a number of 

columns and creating layers. A layer can be viewed as the arrangement of objects on top 

of each other with the one on top being on the first layer e.g. text can be on one layer 

while graphical objects on another. Therefore the text layer can be manipulated separate 

from the graphical object layer like for example text moves separate from the objects. 

Another good example is you can make the graphical object layer transparent in order to 

make the text in a layer behind the object visible. 

Printing: Because the main purpose of any desktop publisher is to produce publication s, 

this cannot be accomplished without printing. Desktop publishing software therefore 

helps the user prepare what is referred to as an artwork in commercial circles for printing. 

 

Types of desktop publishing software 

There are two main types of desktop publishing software: 

Graphical based: They are specifically developed to edit and format graphic objects like 

pictures. Examples are Adobe Photoshop, Corel Draw, harvard graphic etc. This desktop 

publishers have superior image handling capabilities like setting resolution, brightness, 

contrast, cropping and filling images of all types with colour. 

 

Layout based: These types of desktop publishers are specifically developed to create 

different page layout designs for text and pictures. Have you ever wondered how the 

complicated front page of a newspaper is developed? It is difficult to achieve such 

without a good layout based DTP. Good examples of layout based desktop publishers are 

Adobe PageMaker and Microsoft Publisher. 

 

Designing a publication 

Publications vary in design and formatting. For example, a card has a particular design 

layout that is different from a newspaper. Therefore, publication designs determine how 

they are classified. 

 

Types of publications 

It is possible to produce different types of publications using a desktop publishing 

software. There are several types of publications that can be published namely: 

Cards: These may be for weddings and other special occasions like graduations and for 

congratulations. 
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Certificates: To show completion of courses and special events. These type of 

publications are very sensitive because they must be designed to discourage any type of 

duplication or counterfeits. 

Newspapers, magazines, pamphlets and newsletters: Have news targeting a group of 

people. They may have many text and graphical layouts and designs. 

Books: Are bulky publications with many pages bound together in the same publication. 

Calendars: Apart from showing dates, they are used by companies to advertise their 

products hence most of them have heavy catchy graphics. 

 

Running Adobe PageMaker 

Currently PageMaker versions 6.5 and 7.0 are the most common desktop publishing 

software developed by Adobe PageMaker. Other Adobe products includes Adobe 

Photoshop mainly used for editing and formatting photographs, Adobe illustrator used 

for creating complex freehand artwork such as drawings and logos etc. 

 

Starting Adobe PageMaker 

1. Click the Start button and then point to Programs 

2. From the programs sidekick menu, point to Adobe group then select PageMaker. 

Figure 4.1 shows how to start PageMaker in a typical Windows environment. 

3. The PageMaker program starts and provides the Document Setup dialog box. If the 

Document setup dialog box is not displayed, then click File menu and select the New 

command. 

4. In the Document Setup dialog box similar to the one in Figure 4.5 specify the 

publication setup options. 

5. Click OK to apply the selected options. A publication window similar to the one in 

Figure 4.2 is now displayed. 

 

PageMaker screen layout . 

The PageMaker application window looks like most application windows for programs 

you have used before. It also has a title bar, menu bar and scroll bars. However, you will 

note that unlike most of the Microsoft applications you have used before, Adobe 

PageMaker does not have a status bar on its application window. The most notable 

difference between a desktop publishing software such as PageMaker and a word-

processing software such as Microsoft Word is that a desktop publishing software 

 

has its printable work area centered on a pasteboard as shown in Figure 4.2.  

The PageMaker publication window is made up of the following layout components: 

 

1. The pasteboard.  3. The toolbox.  5. Rulers 

 

2. The printable area.  4. Master pages. 

6. Control pallete. 

 

The pasteboard 
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A pasteboard is a large blank area where you place text and graphical objects before 

arranging them neatly on the printable work area enclosed with margins. 

 

The printable area 

It is the area that looks like a page surrounded by margins on the pasteboard. Any object 

or text that is placed on the printable area will be printed by the printer. 

 

The Toolbox. 

This is a set of buttons that contains various tools you can use to create and manipulate 

your publication it has the following tools 

Line tool 

Rectangle tool 

Ellipse tool 

Polygon tool 

Hand tool 

Pointer tool  

Rotate tool 

Text tool  

Cropping tool 

Constrained tool  

Rectangle frame tool  

Ellipse frame tool  

Polygon frame tool 

Zoom tool 
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The function of each tool can be summarised as follows: 

 

 

Tool 

 

Purpose 

 

Pointer 

 
Select, move, and resize text blocks and graphical 

objects 

Text 

 

Type, select, and edit text. 

 

Rotating Select and rotate objects. 

 

Cropping 

 

Crop i.e. trim imported graphics 

Line Draw straight lines in any direction 

Constrained line Draw vertical or horizontal lines. 

Rectangle 

 

Draw squares and rectangles. 

Rectangle frame 

 
Create a rectangular placeholder for text and Graphics. 

Ellipse Draw ellipses and circles 

Ellipse frame Create a circular or oval place holders for text and graphics 

Polygon Draw basic polygons such as triangles, pentagons, stars etc 

Polygon frame Create polygonal place holders for text and graphics 

Hand  Scroll the page or to preview and test hyperlinks 

Zoom Magnify or reduce the area of the page 

 

Master pages icons 

At the bottom of the publication window is a bar that holds icons representing each page 

in the publication. These icons are called page thumbnails. To move to a page, just click 

its thumbnail. When you click the master page thumbnail(s), the master page(s) are 

displayed. A master page is used to design the general layout that needs to be applied in 

all other pages of the publication. (Figure 4.4) 

  

Rulers 

Each publication window can include horizontal and vertical rulers. They extend along 

the top and left borders of the window. You can display rulers when you need them and 

hide them when you want more room on the screen to view a publication. The rulers must 

be visible to help the user to manually create ruler guides, which are nonprinting 

extensions of the ruler as well as measure an object size. 

 

Control pallete 

It is a shortcut toolbar mainly having text and paragraph formatting command icons. 

 

Setting up a publication 
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Sometimes, it is necessary to change the setup options of a publication e.g. page size, 

margins, orientation etc. 

 

To change publication's setup: 

1. From File menu, click Document Setup. A dialog box such as the one shown in Figure 

4.5 appears. 

2. Select the following page set up options: 

(a) In the Page size list box, select the appropriate size. When you select a page size, its 

dimensions appear in the Dimensions text boxes. Alternatively select custom size then 

use the dimensions text box to specify a custom page size of up to 1065 by 1065 mm. 

(b) Select page orientation by either clicking Tall for portrait or Wide for landscape 

orientation. 

(c) Click Double-sided to set inside and outside margins to accommodate binding on 

pages that will be printed on two sides. 

(d) Click Facing pages if you want left and right pages displayed  together as a two-

page spread on the screen. 

 (e) Enter the number of pages you initially plan for-the publication. 

 (f) Click OK to effect the changes. 

 

Setting up a publication using master pages 

If you are creating a publication that will have several pages such as a book or a project 

report, it is important that you layout a common layout foundation for all pages for the 

sake of consistency and cohesiveness. These pages used to design a common layout to be 

applied in the other pages of the publication are called master pages or a document 

master. You can create, modify, and delete objects on master pages just like any other 

objects, but you must do so from the master pages themselves. 

 

The document master applies to all pages in the publication until you' specify otherwise, 

and cannot be renamed or removed from the publication. To switch to master pages, 

simply click the master page icon(s) then: 

1. Place non-printing ruler guides on the master pages to help you place text and graphics 

accurately and consistently throughout your publication. Non-printing ruler guides are 

vertical or horizontal lines 

. you place on printable area. You place the guides by positioning. the mouse pointer on 

the ruler then dragging the guide to the required position. 

2. Create basic design elements on the master pages, including text and graphics that you 

want to appear on each page in your publication. 

 

Setting up margin guides 

Margin guides are very important because they define the printable area of your 

publication. 

 

To change margin settings; 

1. From File menu, click Document Setup 
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2. In the Setup dialog box 

(a) For a double sided document enter the values for inside and outside margins to 

accommodate binding for a document that will be printed on both sides. For Single sided 

pages, set the left and right margins. 

(b) Enter the value for the Top and Bottom margins. 

3. Click OK to close the setup-dialog box and effect the changes. 

 

Saving the layout 

Once you complete setting up your publication layout, it is important you save it before 

you start entering text and graphics. 

To save the layout: 

1. To save the publication for the first time, from the File menu, click Save As or click 

the Save button on the toolbar. 

2. In the Save As dialog box, specify the name of the file and the storage location of your 

publication then click Save button 

3. To save changes made to a publication, from the File menu, click Save. 

 

Displaying and hiding rulers 

If the rulers are not displayed, click the View menu, then Show rulers to display them. To 

hide the rulers, click the View menu then Hide rulers. 

 

Selecting ruler measurement units 

It is possible to set different measurements on both rulers. For example, you can set the 

vertical rule in millimetres and the horizontal in inches. Therefore if you want to use 

common units, you must set each ruler measurement independently. 

 

To set the measurement units, 

1. Right click a ruler separately. A drop down list displays available measurement 

systems that is inches, decimal, millimeters, picas and Ciceros as shown in Figure 4.6 

below. If you are not familiar with some of these units, it is advisable you use 

millimeters. 

2. Select the measurement system option you want to use. 

 

Manipulating text using the toolbox 

 

Manipulating text 

 

Using text tool 

To create a text block with the text tool: 

1. Click the text tool from the toolbox. The pointer turns into an I-beam. 

2. On an empty area of the page or pasteboard click or drag a rectangular area to define a 

text block or frame. If you click without dragging, a text block the width of the column or 

page will be created. It is the text frame that defines the space you want the text to 

occupy. The borders of a text block remain invisible until you click the text with the 

pointer tool. 

3. Type the text you want. 



 74 

 

Using text frame 

You can create text by using a frame tool or by converting any object you have created 

with the drawing tools except a line into a frame. Text frames do not change height or 

width as you add or remove text. 

 

To add text into a frame: 

1. Draw a frame using any of the frame tools that defines the shape you want the text 

block to take. Alternatively select a drawn shape, from Elements menu, point to Frame 

then click Change to Frame. 

2. Do one of the following: 

(a) Click the text tool, click in the frame, and then type or paste text from the clipboard 

(b) From the File menu click Place, double-click the file that contains the text you want 

to place in the text frame. When the cursor becomes a loaded icon, click inside the text 

frame to place the text. 

 

You can also add text into a text frame by: 

1. Selecting a text block, hold down Shift, and then select an empty frame. 

2. From the Element menu, point to Frame and click Attach Content. The text flows into 

the frame and the text block disappears. 

 

Manipulating graphical objects using the toolbox 

The toolbox has several graphic drawing tools. For example, the polygon tool helps a 

person to draw polygons and the ellipse tool is used for drawing circular objects. All 

these tools enables a person to apply stroke and fill patterns. For more complex graphics, 

PageMaker allows a person to import pictures from other applications and to place them 

in the publication. A stroke refers to a line style while a fill refers to applying patterns 

such as shading. Figures 4.7 (a) and 4.7(b) shows examples of fill and stroke respectively 

applied to simple rectangular graphical objects drawn using the polygon tool. 

 

Applying stroke and fill 

Once you create a graphical object, you can enhance it by applying stroke and fill. To 

apply stroke or fill: 

1. Select the object you want to apply stroke or Fill. 

2. From the element menu either point to stroke to apply a line style or fill to fill the 

object with a background colour or pattern. Alternatively, click the fill and stroke 

command to set the fill and stroke options in the dialog box as shown in Figure 4.8. 

 

Moving and resizing text and graphical objects 

Once you create text and graphical objects, you can adjust the size, shape, or location of 

an object. 

To move a text or graphical object: 

1. Click the object to select it then position the pointer tool anywhere inside the text or 

object. 

 2. Drag the text or object to a new position. 



 75 

 

To resize text or object: 

1. Select the text or object with the pointer tool. Selection handles are displayed at the 

comers of the text block or the object. 2. Position the pointer on the selection handle and 

drag to the required size. 

 

Editing a publication 

The term edit means making changes to a publication. In most cases, editing would 

include the process of correcting spelling mistakes, replacing words etc. 

 

You can search for specific occurrences of a word or group of words in your publication 

and make the necessary changes. PageMaker comes with two special editing tools 

namely the Find and Change tool and the Spelling tool. 

 

Before editing the publication, you must open it in the story window. PageMaker defines 

each text block as a story. Once text is in PageMaker, it is part of a story. A story is a text 

block that PageMaker recognizes as a single unit. A story can be one letter or several 

hundred pages of text, and can be contained in a single text object or threaded through 

many different ones. 

 

Find and change tool 

This editing tool helps a person to search for a particular word or a phrase and replace it 

with another one. To find and change a word and or a phrase in the publication: 

1. Using the text tool, click an insertion point in a story, or select a range of text if you 

want to limit your search to that section. 

2. Click Edit menu then select Edit story command. The publication now opens in the 

story window showing only the text but not the graphical objects.' 

3. Click Utilities then Find or Change. A dialog box such as the one shown in Figure 4.9 

is displayed. 

4 In the Find What text box, type or paste the text you want to find. To change the text, 

type new text in the Change To text box. To search for formatting only, leave the text 

boxes blank.  

5. Select Match Case and Whole Word as appropriate.  

6. In the dialog box, specify the formatting to search for and, if appropriate, how you 

want to change it, and click OK 

7. Select options to determine the scope of the search e.g. in all open publications or only 

the current one. If you search the current publication only, select Search Story option. 

8. Click Find to begin the search. 

9. Click Find Next to continue with the search operation 

10. Once you are through, click Story menu then Close Story. Alternatively press 

Ctrl+W. 

Spell checking 

To check spelling in one or more publications: 

1. Click the insertion pointer anywhere in the publication or select the range to be spell 

checked. 
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2. From the Story Editor menu, choose Utilities then Spelling. A dialog box as shown in 

Figure 4.10 appears. 

3. Specify the scope of the search either as: 

(a) In selected text. 

(b) In the current story only. 

(c) In all stories in the publication. 

4. Specify spell checking options: 

(a) Checking alternate spellings lets you see suggested replacements for 

misspelled words. 

  (b) Checked show duplicates displays/repeated words. 

5. Click the start button and spell checking begins. 

 

Formatting a publication 

This refers to applying special attributes to text, graphical objects and pages in order to 

make them attractive and appealing to the eye. Therefore, formatting may include things 

like font sizing, bolding, changing text colour, adjusting picture brightness and contrast 

and formatting columns on the page. 

 

Text and paragraph formatting 

To format your publication, you can either use commands available in the Type menu or a 

control palette. The Control palette is a strip that contains command buttons and list 

boxes that let you assign attributes to text and graphical objects: 

 

To display the control palette 

From Window menu, click show control pallet The Control palette appears floating on 

top of your publication (Figure 4.11). You can move it by dragging the bar at the left 

edge of the palette. 

The contents of the Control pallete  vary. Depending on which tool is selected from the 

toolbar or from itself. The two types of control palettes are the object mode and text 

mode. The text mo e can be selected by clicking the Character view or paragraph view 

button. There are two types of text modes namely; 

1. The character view that is, when the T tool on the pallete is selected. This means that 

you can apply character attributes to selected text. Character attributes determine how 

text looks on the page. such as font type, size, or style (bold, italic or regular). 

2. The paragraph view that is, when you select a paragraph and you click the button below 

the T on the control palette (labelled M) in Figure 4.11. Figure 4.12 is displayed. You can 

apply paragraph styles, select alignment options, and other paragraph attributes. 

In object view i,e. when a graphical object is selected, it lets you apply attributes related 

to the object such as rotating, moving, resizing etc. 

 

To format text: 

1. Using the text tool, select the text you want to format. 

2. From the Type menu of the Control palette, choose the formatting attribute you want. 

 

To format several text attributes at once 
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1. With the text tool, select the text you want to format. 

2. From the type menu, click character command 

3. In the Character Specifications dialog box select text attributes such as font, size, type, 

colour, position (normal, subscript, superscript etc.) then click ok 

The simplest way to format text attributes is by using the control palette. In character 

view the control palette has the following main formatting sections 

 

1. Font list box and style buttons 

2. Font size and leading list box  

3. Tracking and Horizontal scale 

 

Changing text colour 

1. Select the text. 

2. From Window menu choose Show Colors. 

3. In the colors dialog box, click the Colors tab. 

4. Select the colour you wish and it will apply on the selected text. 

 

Changing case 

As with Microsoft Word you can also change text case to upper or lower case, sentence 

case e.t.c. 

To change case: 

1 Select the text you want to change case. 

2 Click Utilities menu, point to Plug-ins, and then click Change case. Change case dialog 

box will be displayed as in Figure 4.1 

3 Select the case you want 

4. Click Apply to preview the change 

5. Click OK to close the dialog box. 

 

Formatting text to superscript and subscript 

Superscript refers to text that is positioned slightly higher than the rest on the same line 

e.g. the power of 3 in 103 while subscript refers to text slightly below the same line such 

as the number 2 in H2O. To format text to superscript or subscript; 

1 Select the text you want to style as superscript or subscript. 

2 From Type menu, click Character and the dialog box in Figure 4.14 appears.  

3. In the Character dialog box, select either superscript or subscript from Position list box 

as shown then click OK. 

To remove superscript or subscript format:  

1. Repeat step 1 and 2 above 

2. In the character dialog box, select Normal from Position list box, and then click OK 

 

Drop cap 

rop cap refers to text formatting where the first character in a line is bigger and drops 

down to occupy the space in the next lines as shown by the first letter D in this paragraph. 

 

To apply drop cap: 

1. Select the character you want to drop 

D 



 78 

2. Click Utilities menu, point to Plug-ins, and then click Drop cap. 

3. Specify the number of lines you want the character to occupy in the Size box as shown 

in Figure 4.15. 

4. Click Apply to preview the format and then OK to close the dialog box.  

Paragraph formatting 

You can use either the Control palette to format a paragraph or Paragraph command from 

the Type menu. However the later lets you apply formatting that is not available on the 

Control palette. 

 

Setting indents and tabs 

Indents and tabs are powerful tools for positioning text. Indents move text inward from 

the right and left edges of a margin while tabs position text at specific positions. You can 

set indents by moving the indent markers in the Indents/Tabs ruler, typing indent values 

in the Paragraph dialog box or type indent values on the Control palette in paragraph 

View. 

 

To set tabs using the Indents/Tabs ruler: 

1. Select the paragraph or paragraphs you want to indent. 

2. From Type menu, click Indents/Tabs. 

3. On the Tab ruler, click a tab-alignment icon (left, right, center, or decimal) for the first 

tab you want to set. See Figure 4.16. 

4. Drag the new tab marker along the ruler 

5. If you want the tab leader, click the Leader button then choose the type of leader you 

want. 

To set indent using the Control palette: 

1. Select a paragraph or paragraphs you want to indent.  

2. On the Control palette, click the paragraph-view button.  

3. Type values for the indents in the Indent text box then press the Enter key. 

 

To set an indent using the Paragraph command: 

1. Click an insertion point in a paragraph, or select a group of paragraphs.  

2. From Type menu, select Paragraph. 

3. Type values for the Indents options, and then Click OK. 

 

Adding space above or below paragraphs 

You can control the vertical space between paragraphs by specifying the amount of space 

before or after selected paragraphs or all paragraphs of a certain style. 

NB: PageMaker never inserts space before a paragraph set to begin at the top of a column 

or page (using the Page Break Before or Column Break Before attribute). For those cases 

you must add the extra space manually by typing one or more paragraph returns. 

 

To increase or decrease space before or after a paragraph: 

1. Select the paragraph you want to edit. 

2. Choose Type then Paragraph. 

3. In the paragraph Space options, specify the values you want in the Before and After 

text boxes. 
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Page formatting 

This refers to formatting the whole page and may include things like column guides. 

 

Columns guides 

Column guides helps you divide the pages into columns that make the publication look 

more organized. The idea is to divide a large page into short readable sentence sections. 

Imagine if a newspaper page was not divided into columns! Therefore columns are 

mostly used in designing large publications, newspapers and journals. The difference 

between column guides and margin guides is that margin guides are around the edges of 

the printable page while column guides may split the page at the center. PageMaker. 

marks margins with a blue line but column guides with pink coloured lines. 

 

To setup more columns: 

1. Turn to the publication page or master page 

2. From Layout menu, choose Column Guides. You can setup column guides separately 

in a double sided facing pages by clicking Set left and right pages separately check box as 

shown in Figure 4.17. 

3. Enter the number of columns you want on the page and the space you want between 

columns. If you are setting left and right pages separately, enter values for both pages. 

4Select Adjust Layout if you want existing text and objects on the page to adjust to the 

revised column setup. 

5. Click OK. 

 

Moving and locking columns 

You can move the column guides by dragging them. The two lines forming the gutter 

between columns move in pairs and the space between the two lines remains consistent. 

Text and graphics already on the page are not affected when you drag column guides. 

Once you have set up your columns, you can lock them in place to prevent accidental 

moving. 

 

To lock or unlock column and ruler guides: 

 From View menu, click Lock Guides. 

Page numbering 

To print page numbers in a publication, you must set the page numbers in the master 

pages. You do this by adding a page-number marker (a special character) that keeps track 

of the page order in the publication and ensures that each page is numbered correctly at 

all times. 

 

To add page-number markers to master pages: 

I. Click the master page(s) icon 

2. Click where you want the page number to be placed. 

3. Press Ctrl + AIt +P. Page-number markers appear as RM (right master) or LM (left 

master) on the master pages but actual page numbers are displayed on each page of your 

document. 
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Changing page number style  

By default, PageMaker applies the Arabic page numbering style ie 1,2,3,..... 

 

To change the style: 

1. From File menu click Document Setup. 

2. In the Page setup dialog box, click Numbers. 

3. Select the numbering style you want to use then click OK to close the Page Numbering 

dialog box. 

4. To start page numbering from another number other than the default 

one ( which is usually 1), type the starting page number in Start 

Page # box in the Document setup dialog box. 

 

Rearranging pages 

In PageMaker, you can change the order of your pages by rearranging page thumbnails 

(icons at the bottom of the window that represent pages). Changing the order of pages 

does not affect the text objects in your publication even though they may have moved to 

different pages. 

 

Sorting pages 

1. From Layout menu, click Sort Pages.  

2. Select the page or pages you want to move either a single-sided page or a pair of facing 

pages. To select one page in a pair of facing pages, press Ctrl and click the page. 

3. Drag the selection to the location you want. To insert a selection between a pair of 

facing pages, press the Ctrl key and drag the selection over the facing pages. Notice that a 

black bar indicates where the selected pages will be inserted. 

4. Release the mouse button to drop the page onto the new position. PageMaker 

automatically renumbers the pages. The original page icon appears dimmed and another 

page icon appears beside the thumbnail to indicate its new page number. 

5. Click ok to change the page order. 

 

Inserting page and column breaks 

Sometimes you may want certain text or paragraphs such as a new chapter to start at the 

top of a column or page regardless of editing or reformatting elsewhere in the document. 

 

To set a page or column break: 

   . 

 1. Select the paragraph or text you want to move to another column or page. 

2. From type menu, select paragraph to display the paragraph specifications dialog box. 

3. Check Column Break Before to force the paragraph to start at the top of the next 

available column or page break before as shown in Figure 4.19 to force the paragraph to 

start at the top of the next available page. 

Adding headers and footers to a publication 

A header refers to a line of text such as a page number, date, or a company name usually 

printed on the top margin of each page in a large document. 
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A footer on the other hand is a line of text printed in the bottom margin. 

 

You can use the same header and footer throughout or use running headers and footers 

that indicates the content of each page as is the case in dictionaries, telephone and address 

directories. 

 

Defining consistent headers and footers 

To define header or footer common throughout the publication  

1. Click the master page(s) icon 

2. At the top of the page, click where you want header to appear or at the bottom click 

where you want the footer/header to be placed. 

3. Type the text that you want displayed on every page in your publication. 

 

Defining Running headers and footers 

1 Select the text block you want to use to create running headers and footers using the 

pointer tool. 

2 Click Utilities, point to Plug-ins and then select Running Headers and Footers. A dialog 

box such as the one shown in Figure 4.20 is displayed with preview page that helps you 

correctly position the header or footer. 

3. Click the place icon and drag the header/footer place holder onto the text page. 

4. From content list box, select the words that will be used as headers or footers on every 

page e.g. the first word in the first paragraph then click Add. You can click the Preview 

button to preview the running headers and footers 

5. Click ok 

 

Tracking and Kerning 

Tracking refers to changing the visual denseness or openness of characters in a line while 

kerning is fixing particular pairs of letters that are too close or too far apart from each 

other such as To, Ta, We, we, Wo etc. 

 

To apply a track: 

1. Select the text you want to track. 

2. From Type menu, choose Expert Tracking. 

3. Choose one of the five tracks options i.e. No Track, Loose, Tight or Very Tight as 

shown in Figure 4.21. 

 

Very loose, 

 

To automatically kern a pair of characters: 

1. Select the text you want to kern.  

2. From Type menu, click Expert Kerning 

3. In the dialog box such the one shown in Figure 4.22, click the appropriate slider button 

to make the text either tighter or looser.  

4. Click OK to apply the expert kerning. 
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To set a word or letter spacing: 

1. Select one or more paragraphs. 

2.From the Type menu, click Paragraph to display the dialog in Figure 4.23. 

3. In the Paragraph dialog box, click Spacing to display Spacing dialog box. 

4.In the Word Space or Letter Space text box, type new values.  

5. Click OK. 

 

Measurements 

 

Using rulers to measure objects 

When using Page Maker, you can be able to design page layouts and graphics that are 

exact in measurement as specified using the horizontal and vertical rulers. The idea is to 

drag ruler guides to mark an area of the screen where you want to insert graphics or text 

that can fit in the guides. 

For example, to draw a rectangle of 5cm by 5cm, set the rulers to measure in millimeters 

then drag and place ruler guides from the horizontal and vertical rulers to create a 5 x 

5cm region on the screen. Finally, select the polygon tool and drag a polygon that fits 

exactly inside the marked region as shown in Figure 4.24. 

 

Formatting graphical objects 

Using the PageMaker tools and formatting effects, you can create very complex graphical 

objects. 

Changing fill and stroke of graphics 

To change fill or stroke of an object:  

1. Select the object by clicking it. 

2. From Element menu click Fill and Stroke.  

3. Select the type of fill or stroke you want.  

4. Select colors for the fill and stroke. 

To apply fill: 

1. Select the object 

2. From Element menu, point to Fill then select the fill pattern you want to apply. 

To apply stroke: 

1. Select the object 

2. From Element menu, point to Stroke then select the line style you want to apply. 

 

Reshaping objects 

To apply rounded comers to rectangles and squares: 

1. Select the rectangle or square you want to change comers 

2. From Element menu, choose Rounded Corners. 

3. Select the comer style you want, and then click OK. Figure 4.25 shows one rectangle 

without and another with rounded corners. 

 

Reshaping a polygon 

Once you draw a polygon, you can change it from the default rectangle or square to 

triangles, pentagons, hexagons and even a star. 

To reshape a polygon: 
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1. Select the polygon you want to reshape. 

2. Double click the selected polygon. PageMaker displays reshape placeholders. 

3. Reshape the polygon by dragging the vertices place holders. 

 

To set the number of sides or create a star object: 

1. Select a polygon you want to reshape, 

2. From Element menu click Polygon Settings, 

3. In the Polygon settings dialog box, specify the number of sides you want, from three to 

a hundred. 

4. To create a star, enter a value in the Star inset box. A value of 0% means no star while 

100% represents a star whose vertices meet at the centre.  

5. Click OK. 

Copying an object: 

1. Select one or more objects. 

2. From Edit menu, choose Copy. 

3. Position the insertion pointer where you want to place the object.  

4. From Edit menu, select paste. 

 

NB: You can quickly copy an object by right clicking it then selecting the copy command 

on the shortcut menu then paste in a new location. Alternatively, select the object then 

press Ctr+C to copy and Ctrl +V to paste in a new place. 

 

 

Wrapping text around a graphical object 

One of the best ways to enhance a publications visual impact is to wrap text around 

graphical objects. Wrapping determines how text behaves around an object. For example, 

you can select a wrap that makes text to surround an object without displacing it as 

shown in Figure 4.27(a). 

 

To wrap text around an object:  

1. Select the object. 

2. From Element menu, choose Text Wrap to display the dialog box in 

Figure 4.27(b). 

 

3. Click the middle wrap option as shown in Figure 4.27 (b) 

4. Specify a Text Flow option. The leftmost icon makes the text jump the object to the 

next page or column, while the middle icon allows text to jump over the object and 

continue on the same page. The rightmost icon creates a rectangular text wrap around all 

sides of an object. 

5. Enter standoff value (distance of the text from each side of the graphic) for the 

boundary. 

7. Click OK and notice how the text wraps around the object. 

 

Importing graphics 

You can import a graphic or text directly from another file or application by using a 

process called placing in PageMaker. In most cases, graphic files will be created in 
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graphical based desktop publishers or picture editing software then imported into 

PageMaker. PageMaker has a very powerful object import engine that can be activated by 

the Place command. 

 

The Place command is the main importing method. When you place text or a graphic, 

PageMaker establishes a link to the source file on the storage device (unless the file is an 

HTML document). 

To import a graphic: 

1. Click the pointer tool. Select the frame in which you want to place the graphic. If you 

do not wish to place it in a frame then ignore this step. 

2. From File menu choose Place. 

3. Select the file you want to place, and then click the Open button. 

4. The cursor changes to become a loaded icon. Clicking any place on the paste board 

will place the new graphic at the clicked location. 

NB: If you place using text tool, then the graphic that will be placed will be an inline 

graphic contained within the text object and will behave like text. It will become hard to 

format it separately as an object. 

 

Grouping and ungrouping objects 

You can group several objects into one, especially if you want to format, resize or move 

them as a single entity. 

 

To group objects: 

1. Using the pointer tool, hold down the shift key as you click the objects to be grouped. 

This selects multiple objects. 

2. From Element menu, choose Group or simply press Ctrl + G on the keyboard. 

3. To select an object within the group then press Ctrl as you click the object. 

To ungroup objects: 

1, Select the Group. 

2. From Element choose. Ungroup. 

 

Locking objects 

You can lock individual objects in place in order to help preserve the design of your 

pages through all stages of production. You can change the attributes of a locked object, 

provided the change does not affect the object's size or position. For example, you can 

change a colour or fill applied to a locked object, but not its degree of rotation or its 

skewing angle. 

 

To lock or unlock an object:  

1. Select the object. 

2. From Element choose Lock Position to lock. Otherwise select. Unlock to unlock a 

locked object. 

 

Rotating an object 
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The process of rotating an object falls under a group of operations called transformations 

because rotation changes the angular placing of an object. Other transforming operations 

include skewing and reflecting objects. However, this book limits itself to rotating 

objects. 

To rotate an object with the rotating tool: 

1. Select the object. 

2. Select the Rotation tool from the toolbox. The pointer changes and becomes a Star 

bust. 

3. Position the Starburst at a fixed point or around the centre of the object. 

4. Drag the starburst away from the fixed point, in the direction you want to rotate the 

object. To rotate an intervals of 45 degrees, press Shift as you drag clockwise or 

anticlockwise. The rotation lever helps you control the amount of rotation. The farther 

you drag the starburst away from the fixed point, the more control you'll have when you 

rotate the object. 

5. When the object is in the desired position, release the mouse button. 

 

Cropping an object 

When you import a graphic from another program or publication, you can cut off 

unwanted parts of the graphic starting from the edges that you do not want to print by the 

crop place holders. 

 

To crop a graphic using the cropping tool: 

1. Select the cropping tool, then the graphic that You want to crop to display the place 

holders. 

2. Position the cropping tool so that the place holder shows through the center of the tool. 

3. Hold down the mouse button to turn the cropping tool into a double sided arrow, and 

drag inwards until only the part of the graphic you want in your publication remains. To 

show more of the graphic, drag away from the center of the graphic. 

4. To move the graphic within its frame, position the cropping tool at the centre of the 

graphic and hold down the mouse button. (in Windows, hold down the left mouse button. 

5. When the hand appears, drag until you see the part you want to appear in your 

publication, then release the mouse button. . 

 

Printing a publication 

Because. the main purpose of any desktop publisher is to produce publications, it is 

impossible to do so without printing. The choice of a printer depends on the quality of 

hardcopy desired. 

 

To print a publication: 

1. From File menu, click Print. A dialog box appears in which you can 

specify the following: 

(a) The printer that you wish to use. 

(b) The range of print in the Ranges box if you do not wish to print whole document. 

(c) Number of copies to print per page in the Number of copies box. 
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(d) Whether to print blank pages or not. 

(e) The print orientation. 

(f) Whether to print both pages. 

2 Click Print to start printing. 

 

 

 

INTERNET AND E-MAIL 

 

Chapter outline 

 

5.1 Introduction. 

5.2 Definition of the internet. 

5.3 Development of the internet. 

5.4 Importance of the internet. 

5.5 Internet connectivity requirement. 

5.6 Internet services. 

5.7 Accessing the internet. 

5.8 Electronic mail. 

5.9 Accessing information on emerging issues. 

 

Introduction 

Computers can be connected together using data transmission media like cables, to 

communicate with one another. Communication in this case will be in the form of 

exchange of data and information. Such interconnection of computers to achieve message 

transfer is called networking. This is because the computers are linked to form a net. 

 

In most cases computer networks are unique to an organization. For example the 

computers in your computer laboratory may be networked. Such a network is local in 

nature hence it is usually called a local area network (LAN). 

 

Definition of the Internet 

The term Internet can be broken down into two words, inter and net which implies that 

there is an interconnection of networks. Internet is therefore a large network of networks 

that covers the whole world and enables millions of computers from different 

organizations and people 

To communicate globally. Because of its large size and great volume of information that 

passes through it, it is sometimes called the information superhighway. 

 

Because of the flexibility of Internet technology, many organizations are creating their 

own private networks using the technology of the Internet. In this book we shall refer to 

the Internet (with capital letter I) as the information superhighway and the internet (with 

lower case letter (i) to refer to smaller networks. 

 

5.3 
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Development of the Internet 

In 1969, a research body in the USA called Advanced Research Projects Agency (ARP ) 

set up a computer network that connected four universities and was given the name 

ARPAnet. This network is viewed as the forerunner of today's Internet. The aim was to 

allow sharing of data and information between computers. The main benefit was that 

there was fast communication between researchers through electronic mail or e-mail.  

ARPA's goal was to allow multiple users to send and receive information at the same 

time. The network used a special data transmission technique called packet switching 

which was later adopted for the Internet. A computer would send a packet that contained 

data, destination address information, error detection control information and packet 

sequencing information. By 1973 e-mail was the most common service on the Internet. It 

was not until 1979 that the first media companies connected to the Internet. 

 

By 1981, many people had seen the importance of computer networking and the Internet. 

ARPAnet formed the backbone on which many organizations started connecting to, hence 

expanding it. The American military also became a big user of the Internet because they 

could communicate and tap into the resources available on the net. Next, the American 

Government decided to access the Internet for commercial purposes hence greatly 

increasing the traffic. By this time, for every twenty days, a new host computer was 

connected to the net. 

 

By 1987, the Internet boasted of 10 000 host computers. However, its access was largely 

limited to the United States of America and some nations in Europe. As the importance of 

the Internet grew, businesses spent billions of dollars to improve it in order to offer better 

services to their clients. Fierce competition arose among software and hardware 

manufacturers as they came up with new technology to meet internetworking needs. The 

result was a great increase in message transmission capacity (bandwidth) and it became 

cheaper to work with the Internet. 

 

By 1994, 3 million computers were connected to the Internet. Today, the Internet has 

grown and covered the whole world. Governments, private organizations and individuals 

are using the Internet in all spheres of daily life to send messages and conduct business. 

 

Importance of Internet 

The Internet is an extensive system of interlinked yet independent networks. It has 

evolved from a specialised communication network previously only used for military and 

academic purposes to a public network that is changing the way people carry out their 

daily activities. 

 

The Internet is playing a very important role in all aspects of life, leading to the 

emergence of an elite society called the information society. The Internet's importance 

can be between through its contribution to research, news and information dissemination, 

leisure and communication, a place to do business and many other profitable activities. 

 

Internet connectivity requirements 



 88 

For a computer to be able to connect to the Internet, there are several requirements one of 

them is to connect to a telecommunication service provider in order to transmit data over 

a wide region. This section seeks to discuss some minimum requirements for Internet 

connectivity to be achieved. 

 

Telecommunication facilities 

The Internet heavily relies on telecommunication facilities like the telephone lines, 

telephone exchange stations and satellite transmission in order to cover the whole wide 

world. Indeed, without these facilities, the Internet is as good as dead. 

 

Therefore, a computer is connected to the external world through a telephone line and has 

to dial a remote computer on the net to establish a connection for data transfer. Dial-up 

connections, however, are quickly being replaced by dedicated digital data transmission 

telephone lines called dedicated digital leased lines. A leased line connection ensures 

constant and quick connection to the Internet unlike the dial-up that you need to dial 

every time you need to access the Internet. 

 

Transmission of data on land takes the form of telephone exchange to telephone 

exchange until the data reaches the destination. However, intercontinental transfer of data 

is achieved by having satellite base stations transmitting g the data through a wireless 

uplink channel to the satellite. The satellite then sends the data signal to the base station 

on another continent where it is picked up and sent to telephone exchanges 

 

 For transfer to the destination computer. Figure 5.1 shows a simple logical illustration of 

the Internet. 

Modems 

A computer needs a special digital to analog and vice versa interface card called a modem 

that enables it to send and receive data on telephone lines. Remember that voice 

transmission on telephone lines is analog in nature while computers work with digital 

data. However, digital telephone lines make it possible for computers to transmit and 

receive digital data without a modem. 

 

The word modem is short form for modulator - demodulator. During modulation, the data 

to be transmitted is changed from digital to analog so that it can be transmitted on the 

telephone lines. At the receiving end, the data is changed from analog to digital for the 

computer to understand it through a process called demodulation. 

 

In most cases a modem is bought separately and plugged in one of the expansion slots on 

the motherboard. Some modems are external hence the computer may be connected to 

them through a network interface card. Most computers today come with an internal 

modem permanently fixed on the motherboard called an onboard modem. 

 

Internet service providers (ISP's) 

These are companies that offer internet services to end users. For example, in Kenya, 

until recently, the sole gateway to the Internet for a long time was Telkom's Jambonet. 

However, because Jambonet cannot meet the service needs for all users in Kenya, they 
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lease some of their stake to Internet service providers like Africaonline@ and 

Swiftkenya@ who can now provide Internet services to the end users at a fee. 

Internet software 

The Internet interconnects millions of computers and telecommunication devices that 

have different configurations for hardware and software. Therefore, to achieve 

communication between these otherwise incompatible devices, special software called 

protocol is needed. A protocol is a set of rules that governs how two computers can send 

and receive data on the network. 

 

For the Internet, the most common protocol is the Transmission control 

Protocol (TCP) and Internet protocol (IP). As its name suggests, TCP governs how data 

is transferred from one place to the next, while IP determines the addressing system on 

the Internet. For example, each network and computer on the Internet is recognised by a 

special number called the IP address that enables data to be sent and received by it. These 

two are combined to form the TCP/IP protocol suite that is needed by any computer that 

needs to be connected to the Internet. 

Internet services 

The Internet has become very popular in today's world because of the diverse but very 

important services that it offers to people. It is "seductive" i.e. once a person connects to 

it they find themselves falling in love with its power to provide information and services. 

The temptation is to continue using the Internet again and again. 

 

The World Wide Web (www) 

The World Wide Web can be viewed as a vast virtual space on the Internet where 

information pages called websites are installed. Most local area networks have a special 

computer called a server that stores information and data for others on the same network 

to access. In order to connect a network to the internet, the local area network needs an 

Internet server. This server is usually given the name world wide web (www) and has all 

the information that others on the Internet access. Hence, www is created by a network of 

Internet servers! 

 

To enable easier access to information and data on the Internet, a standard method of 

preparing documents to be put on the Internet was developed. This method uses a special 

language such as hypertext markup language (HTML) to prepare documents called web 

pages that are  attractive and can be accessed on the Internet. HTML can be combined 

with other web page production tools to achieve wonderful websites. Individuals and 

organizations establish sites where their web documents can be placed 

 

2for easy access by the external world. Such sites are called websites and each has a 

special address called a uniform resource locator (URL) that can be used to access them. 

For example, one common URL address is: 

http://www.yahoo.com 

The first part (http) stands for hypertext transfer protocol which is a protocol that 

transfers hypertext. www is the name of the Internet server (web server) on which the 

webpage resides. yahoo.com is usually called the domain name of the local area network. 
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It uniquely identifies a particular local area network. On the Internet, two networks may 

have the same web server name but never the same domain. 

 

Electronic mail (e-mail) 

This is the exchange of electronic letters, data and graphics on the Internet.  

Electronic commerce (e-commerce) 

Many companies are increasingly using the Internet to sell and buy goods and services. 

This new business strategy where goods and services are sold over the internet is called 

electronic commerce (e-commerce). 

 

One advantage of e-commerce is that a company can access customers all over the world 

and is not limited by space and time. Hence, small companies that establish websites to 

auction their goods and services not only reduce operating costs but increase their sales. 

For example, most vehicle importers buy vehicles directly from international dealers by 

accessing their websites and placing orders. 

 

However, the major challenges that face e-commerce are that people deal with each other 

without ever meeting physically and there is lack of proper laws to govern such business. 

 

Electronic learning (e-Iearning) 

Apart from the fact that academic materials for all levels of education are readily 

available on the Internet (web), the Internet has opened the door for those who would like 

to do distance education programs and home schooling. Learning through interaction 

with special programs on the computer is called electronic learning (e-Iearning). 

 

Internet fax 

The Internet provides you with complete fax facilities from your computer. You can 

configure fax settings, send and receive faxes, track and monitor fax activity, and access 

archived faxes. Using fax, you can choose to send and receive faxes with a local fax 

device attached to your computer, or with a remote fax device connected to fax resources 

located on a network. 

 

Other Internet services 

1. News media on the net. All major media houses post their daily news on the Internet 

for their clientele to access. Hence information about an event can be sent right round the 

globe within a very short time. 

2. Health information on the net. The Internet provides latest medical news and 

research findings for practitioners and scholars. 

3. Music and entertainment on the net. It is possible to listen to music on the web and to 

watch video clips if your computer is a multimedia machine. 

4. Chatting on the net. People can sign into a chat room and exchange ideas freely through 

discussion. Chat rooms are a common feature and usually put together people of common 

interest to exchange ideas. For example, if you sign into a chartroom for politics, then 

you can exchange political views with otherwise unknown Internet friends who can read 

your typed comments as you view theirs. Try accessing www. Try. Com to see listings of 

chat topics that you can participate in on-line. However, you need to be careful in 
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selecting the people to chat with on the web because some people who use the chat rooms 

have intentions of harming others. 

Accessing the Internet 

There are many applications that enable a person to access the Internet. Such applications 

are called web browsers. Some of them have text interface while the most popular have 

graphical user interface. Perhaps, the most common browsers in the world today are 

Netscape Navigator and Internet Explorer. 

 

Therefore before accessing the Internet, a person must start the browser software. This 

book will use Internet Explorer for demonstration, 

1. The back button returns the browser to the immediate former webpage. 

2. The next button moves the browser to the next web page in case a person had clicked 

the back button.  

3. The stop button tells the browser to stop searching/loading a website.  

4. The refresh button tells the browser to try accessing a web site address again after 

failure 

5. The search button enables a person to search for words on the website.  

6. Clicking the favorites button displays all web addresses in the’ favorites" folder. 

7. The history button displays the website addresses that were visited in the recent past. 

8. The mail button enables a person to view and send mail and WebPages to links. 

9. The print button enables a person to print the web pages. 

10. The Go button tells the browser to load the current web page whose address is in the 

address bar. 

11. The address bar allows the user to type the address of a website to be accessed. 

12. The home button moves the user to the first page of the website. 

 

Log in/sign in 

To access a website, type the full address of the website in the address bar then press the 

Enter key on the keyboard. If the Internet connection is working properly, the browser 

will start connecting to the requested web site or URL. Notice that the status bar will be 

reading something like "connecting to site www.yahoo.com " 

 

Some web sites allow free access to all their pages by all visitors. However, others 

require people to be members hence a new visitor has to register (sign up) by filling some 

on-line forms. The registration process gives the visitor a user name and password that 

can be used to sign in or log on the website for each successive visit. This is very 

common for e-mail account providers like at www.mail.yahoo.com. 

 

Websites that give users a chance to log in are better especially if the services offered 

need some degree of privacy and customizing for 

Individual customers e.g. it would be a gross mistake to have everybody accessing the 

other's e-mail account. 

 

Surf/browse 
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Surfing or browsing is the process of accessing Internet resources like web pages and 

websites. This is done by either typing the URL address of a site in the address bar of the 

browser or by following special links that lead to web pages called hyperlinks. 

 

Hyperlinks and search engines 

A hyperlink is a text or picture on an electronic document, especially web page that 

causes other web pages to open when the link is clicked. A hyperlink can be identified by 

the fact that the mouse pointer changes to look like a palm having four folded fingers 

with the index finger not folded but pointing outwards. 

 

The Internet is a big forest of web pages and websites. Searching for particular materials 

or resources can be a nightmare because of the massive volumes of available documents 

and resources. To make the work a bit easy, special websites that maintain lists of 

hyperlinks are available. These websites are called search engines. They have special 

programs called robots or spiders that traverse the web from one hyperlink to the next 

and when they find new material, they add them to their indexes or databases. Figure 5.4 

below shows one of the most common search engines called Google found at 

www.google.com 

The user searches for a word by typing a few key words in the search field of the engine 

then clicking the search button. The engine searches its database for links to the 

information requested and displays a list of links from which the user can now access 

information by clicking them to open web pages. 

 

Example of search engines include: www.google.com, www.hotmail.com and 

www.yahoo.com. 

 

Downloading/saving/printing web content 

After searching and finding information on the Internet, you may want to save the 

information locally on your computer for future reference. The process of transferring 

information from a remote computer to a local storage is called downloading. To 

download a file, the following procedure is followed: 

1. Right click the hyperlink to the file. 

2. On the shortcut menu, click the Save target as command. 

3. After some searching the browser displays the save as dialog box. Specify the folder or 

drive where the file is to be saved then type a unique name for the file in the name box. 

4. Click the Save button and the download progress dialog appears on the screen. Unless 

otherwise selected, the download dialog will notify the user at the end of the download 

process. 

 Pen the file in its application to view it. 

 

NB: If you download a file whose application is not currently installed on the computer, 

then you may not be able to view its contents. For example, if you download a file that 

was created in Microsoft Word then you can only open it in the same application. 
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To print a file, open it in the application in which it was created then send it to the printer 

for printing. You can also print a web page directly from the browser window by clicking 

File then Print. 

 

Electronic mail (e-mail) 

Electronic mail refers to the sending and receiving of electronic letters and documents on 

the Internet. This feature serves to popularize the Internet even among non-technical 

people. For many, gone are the days when paper mail (of late called snail mail) would be 

sent and the recipient had to wait for long before receiving it. E-mail is fast because it 

takes 

Only a few seconds to reach the recipient regardless of where they are in the world. 

 

E-mail software 

E-mail software falls under a special group of application packages called communication 

SoftArt. It is specially designed and developed to help a person to read and send 

individual text documents on the Internet as long as both the sender and receiver have an 

e-mail address. 

 

Like the normal postal address, an e-mail address directs the computers on the Internet on 

where to deliver the e-mail message. A typical e-mail address would look like this: 

chemwex@yahoo.com 

1. chemwex is the user name and is usually coined by the user during 

E-mail account registration. 

2. @ is the symbol for Hat" which actually separates the user name from the rest of the 

address. 

3. Yahoo. Com is the name of the host computer in the network i.e. the computer on 

which the e-mail account is hosted. 

4. The period H. " is read as dot and is used to separate different parts of the e-mail 

address. 

5. Com identifies the type of institution offering a particular service(s) and is called the 

domain, meaning it is a commercial institution. Other common domains include: 

 

Domain                                                              Type 

 

.edu Educational institution 

.gov Government institution 

.org Non-profit making organization 

.mil Military organization 

.co                                                                    Commercial institution 

 

Sometimes another two letter extension is added after the domain name to show the 

country where the site is located e.g. injsmith@yahoo.co.uk, .uk stands for United 

Kingdom. Other countries domain name includes .ke (Kenya) .ug (Uganda, :tz 

(Tanzania), .jp (Japan), .au (Australia) etc. 

 

E-mail facilities 
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Basically all e-mail software packages provide the user with ability to receive messages, 

display them, reply to the messages, compose new ones and store received messages.

 ' 

 

Mails 

1. Checking mail   In order to check mail the user has to open the email account by 

providing the correct user name and password. While 

In the e-mail account, click the Inbox command to view a link list of all the mails that 

you have received. To view a message, simply click its link and it opens on the screen for 

reading. 

2. To compose a message, click the Col11posebutton. The e-mail software opens a blank 

screen on which you can type the new message. Figure.5.5 shows a typical e-mail screen 

for composing a message. 

 

3. To send mail, type the correct e-mail address of the recipient in the to: text box. Type a 

subject in the subject box e.g. if it is a letter to a friend, type "Hi". Finally click the Send, 

or send / receive button, and your message will be sent. 

4. Forwarded messages can be read and sent on to other people. Most of such messages 

are fun pages, poems, e-cards etc. After reading, 

Simply click the Forward button and then provide the addresses of the recipients. Click 

the Send button to send. 

5. An e-mail message can be saved using the normal procedure for saving e.g. Click File, 

Save as then provide the name of the file and click save button. 

6. To print e-mail, select the text to be printed then click the File - Print command. In the 

print dialog box select the options for the page size, orientation etc. then click the Print 

button. 

 

File attachment: 

E-mail software also enables a person to attach other files like pictures, music and movie 

clips to an e-mail for sharing with friends before sending. The recipient can then 

download the attached files or simply view them on the screen. A good example where 

people use attachments is on-line job applications where a person attaches curriculum 

vitae to an e-mail message. To attach a file: 

1. Start the e-mail software i.e. Microsoft outlook express. 

2. Click File then New or open a composed e-mail. 

3. Specify the recipients address and the subject. 

4. Click the Insert menu then File attachment. A dialog box appears where you chose the 

file you want to attach. 

5. Select the file then click the Attach button. 

6. An attachment bar is inserted in the e-mail window with a name of the file you chose. 

7. Click Send to send the e-mail. 

 

NB: You can also attach a file by simply clicking the attach button. 

 

On-line meetings 
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It is possible to hold on-line meetings with people by sending mail to them. For example, 

on-line interviews may involve a person sending electronic mail composed of interview 

questions to a recipient who can read and answer back immediately. This method may 

not be as effective as a face to face interview or discussion but it is very useful in 

situations where traveling may be impossible or too expensive. 

 

Telephone messages 

Because of integration between mobile telephony and the Internet technology, it is 

possible to send e-mail to a mobile handset and a mobile message to e-mail account. This 

mobile computing is made possible by a special Internet access protocol called wireless 

access protocol (WAP) and wireless markup language (WML). 

 

Contact management 

Most mail programs allow the user to develop an address book which holds 'contact 

information like e-mail addresses of different people along with other necessary 

information. The e-mail software usually provides a simple way of accessing these 

contacts when required. To create a new contact: 

 

1. Start the e-mail software i.e. Microsoft express. 

2. From the tools menu, click Address book or simply click the address book button. 

3. From the address book window click File then: Contact. 

4. Click the Name tab and enter the contact details. 

5. Click the Add button and add the contact into the contact list. 

6. Close the contact window then the address book. 

 

5.9 

Accessing information on emerging issues 

The Internet is a storehouse for all types of information, presented in the form of text 

documents, pictures, sound and even video. Many emerging 

Issues in the world today may not be properly documented in terms of hardcopy 

textbooks and journals but the Internet has a wide range of information concerning the 

issues. Emerging issues in this context refer to HIV/AIDS, drug abuse, environmental 

issues and moral issues. 

 

Therefore, it is already evident that before embarking on finding any information on the 

web, a person needs to carefully plan their search to 

Avoid wasting a lot of time wading through "junk" or useless material. 

I 

 

Steps for searching 

1. Plan for your search. You must develop a search strategy. Consider the following 

questions before starting to search for information: (a) what would be the best place to 

find the information required? (b) What tool best suits the work at hand? 

(c) What key words can best describe the search problem? 
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2. There is always the best place to start the search. One of the best places is on websites 

of leading media houses like www.cnn.com and www.nationaudio.co.ke because you are 

likely to get links to the latest research discoveries in your area of interest. 

3. after checking out on the news houses, you can now open some search engines and 

type the key words in the search field. Use different search engines to look for 

information on all the emerging issues mentioned above because different search engines 

give different search results. 
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DATA SECURITY AND CONTROLS 

 

Chapter outline 

 

6.1 Introduction and definition. 

6.2 Security threats and control measures. 6.3 Computer crimes. 

6.4 Detection and protection 

6.5 Laws governing protection of information. 

 

6.1 Introduction and definition 

Computer information systems are becoming more and more important in daily life. 

Governments, private enterprises and individuals have found the need to protect data and 

information that is in their custody against unauthorized access, disclosure or damage. 

This is because of the rise of the information age and society leading to the subsequent 

view of information as a scarce valuable resource. This has posed threats to data and 

information both from known and unknown sources. 

 

Data and information security Data security involves: 

1. Protection of data and information against unauthorized access or 

Modification. 

2. Denial of data and information to unauthorized users.  

3. Provision of data and information to authorized users. 

 

Data security also includes all the measures that will be taken to detect, document and 

counter the threats to data and information. 

 

Data and information privacy 

Private data or information is that which belongs to an individual and must not be 

accessed by or disclosed to any other person unless with direct permission from the 

owner. On the other hand, the data or information held by a government or organization 

about people is confidential data. This data and information may be seen by many 

authorized persons without the knowledge of the owner. However, it should not be used 

for commercial gain or any other unofficial purpose without the owner being informed. 

This data must also be protected against unauthorized access or disclosure. 

 

6.2 Security threats and control measures 

 

Viruses 

A computer virus is a destructive program that attaches itself to other files and installs 

itself without permission on the computer when the files are opened for use. The virus 

may cause havoc on the computer system, for example, it may delete data on storage 

devices or interfere with the proper functioning of the computer system. 

 

Types of computer viruses include: 

1. Boot sector viruses - they destroy the booting information on storage devices. 

2. File viruses - attach themselves to files. 
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3. Hoax viruses - Come as e-mail with an attractive subject and launches itself when e-

mail is opened. 

4. Trojans - they appear to perform necessary functions but perform other undesirable 

activities in the background without user knowledge.  

5. Worms - viruses that stick in the computer memory.  

6. Backdoors - may be a Trojan or a worm that allows hidden access to a computer 

system. 

Control measures against viruses 

1. Install the latest versions of anti-virus software on the computers. 

Make sure that you continuously update the anti-virus software with new virus definitions 

to counter the new viruses that are being manufactured on a daily basis. 

2. Avoid foreign diskettes in the computer room. If they have to be used, they must first 

be scanned for viruses. 

3. Avoid opening mail attachments before scanning them for viruses. 

 

Unauthorized access 

Data and information is always under constant threat from people who may want to 

access it without permission. Such persons will usually have a bad intention either to 

commit fraud, steal the information and destroy or corrupt the data. Unauthorized access 

may take the following forms: 

 

Eavesdropping 

This is tapping into communication channels to get information. Hackers mainly use 

eavesdropping e.g. to obtain numbers of credit cards. 

 

Surveillance (monitoring) 

  

This is where a person may keep a profile of all computer activities done 

By another person or people. The information gathered may be used for one reason or the 

other e.g. spreading propaganda or sabotage. Many websites keep track of your activities 

using special programs called cookies. 

 

Industrial espionage 

Spying on your competitor to get information that you can use to counter or finish the 

competitor. This is mostly done with an aim to get ideas on how to counter by developing 

similar approach or sabotage. 

 

Also unauthorized access can be as follows: 

 1. An employee who is not supposed to view or see sensitive data by 

 mistake or design gets it. 

2. Strangers who may stray into the computer room when nobody is using the computers.  

3. Forced entry into the computer room through weak access points.  

4. Network access in case the computers are networked and connected to the external 

world. 

 

Control measures against unauthorized access 
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1. Enforce data and information access control policies on all employees. 

2. Encrypt the data and information during transmission (data encryption is discussed in 

details later in the chapter).  

3. Keep the computer room closed when nobody is using it.  

4. Reinforce the weak access points like doors and windows with metallic grills and 

burglar alarms.  

5. Enforce network security measures.  

6. Use files passwords to deter any persons who may get to the electronic files. 

Computer errors and accidental access 

Sometimes, threats to data and information come from people making mistakes like 

printing sensitive reports and unsuspectingly giving them to unauthorized person(s). 

Also, if end users have too much privilege that allows them to change or access sensitive 

files on the computer then accidental access mistakes may occur. 

 

Errors and accidental access to data and information may be as a result of people 

experimenting with features they are not familiar with. For example, a person may 

innocently download a file without knowing that it is self-installing and it is dangerous to 

the system. 

 

Control measures against computer errors and accidents 

1. Give various file access privileges and roles to the end users and technical staff in the 

organization i.e. denies access permissions to certain groups of users for certain files and 

computers. 

2. Set up a comprehensive error recovery strategy in the organization. 

 

Theft 

The threat of theft to data and information is a real one. Some information is so valuable 

that business competitors or some governments can pay a fortune to somebody who can 

steal the information for them to use. Therefore the following control measures should be 

taken to prevent theft of hardware, software and information. 

 

Control against theft 

1. Employ guards to keep watch over data and information centers and 

Backups. 

2. Burglar proofs the computer room. 

3. Reinforce weak access points like the windows, door and roofing 

With metallic grills and strong padlocks. 

4. Create backups in locations away from the main computing centre. 

 

Computer crimes 

6.3 Trespass 

The term trespass here refers to two things. One is the illegal physical entry to restricted 

places where computer hardware, software and backed up data is kept. The other form 

would be accessing information illegally 
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Bon a local or remote computer over a network. Trespass is not allowed at all and should 

be discouraged. 

 

Hacking 

A hacker is a person who intentionally breaks codes and passwords to gain unauthorized 

entry to computer system data and information files. The hacker therefore violates the 

security measures put in place such as breaking through passwords or finding weak 

access points in software. 

 

There are various motivations for hacking. One is that some people like the challenge and 

they feel great after successful hacking, while some do it for computer and software 

producer companies that want to secure their systems by reducing weaknesses discovered 

after professional hacking. The most vulnerable computers to this crime are the 

networked computers faced with hackers working remotely. 

 

Tapping 

In this case, a person sends an intelligent program on a host computer that sends him 

information from the computer. Another way is to "spy" on a networked computer using 

special programs that are able to intercept messages being sent and received by the 

unsuspecting computer. 

 

Cracking 

Cracking usually refers to the use of guesswork over and over again by a person until 

he/she finally discovers a weakness in the security policies or codes of software. 

Cracking is usually done by people who have some idea of passwords or user names of 

authorized staff. 

 

Another form of cracking is trying to look for weak access points in software. For 

example, Microsoft announced a big weakness in some versions of Windows software 

that could only be sealed using a special corrective program prepared by them. Such 

corrective programs are called patches. It is advisable therefore to install the latest 

patches in software. 

 

Piracy 

Piracy means making illegal copies of copyrighted software, information or data. 

Software, information and data are protected by the copyright law. There are several 

ways of reducing piracy: 

 

I. Enact laws that protect the owners of data and information against. Piracy. 

2. Make software cheap enough to increase affordability. 

3. Use licenses and certificates to identify originals. 

4. Set installation passwords that deter illegal installation of software. 

 

Fraud 

Computer fraud is the use of computers to conceal information or cheat other people with 

the intention of gaining money or information. Fraudsters can be either employees in the 
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company or outsiders who are smart enough to defraud unsuspecting people. Some fraud 

may involve production and use of fake documents. 

 

An example of fraud is where one person created an intelligent program in the tax 

department that could credit his account with cents from all the tax payers. He ended up 

becoming very rich before he was discovered. 

 

Sabotage 

This is the illegal destruction of data and information with the aim of crippling service 

delivery or causing great loss to an organization. Sabotage is usually carried out by 

disgruntled employees or those sent by competitors to cause harm to the organization. 

 

Alteration 

This is the illegal changing of data and information without permission with the aim of 

gaining or misinforming the authorized users. Alteration is usually done by those people 

who wish to hide the truth. To avoid this, do not give data editing capabilities to just 

anybody without vetting. Secondly, the person altering data may be forced to sign in 

order for the system to accept altering the information. 

 

Alteration of data compromises the qualities of good data like reliability, relevance and 

integrity. 

 

6.4 

 

Detector and protection against computer crimes 

After seeing the dangers that information systems are faced with due to threats to data 

and information and perpetration of computer crimes, it is important to look at some 

measures that can be taken to detect, prevent computer crimes and seal security 

loopholes. 

 

Audit trial 

This is a careful study of an information system by experts in order to establish or find 

out all the weaknesses in the system that could lead to security threats and weak access 

points for crimesters. An audit of the information system may seek to answer the 

following questions: 

1. Is. the information system meeting all its originally intended design objectives? 

2. Have all the security measures been put in place to reduce the risk of computer crimes?  

3. Are the computers secured in physically restricted areas?  

4. Is there backup for data and information of the system that can ensure continuity of 

services even when something serious happens to the current system? 

5. What real risks face the system at present or in future? 

 

Data encryption 

Data on transit over a network faces many dangers of being tapped, listened to or copied 

to unauthorized destinations. Such data can be protected by mixing it up into a form that 

only the sender and receiver can be able to understand by reconstructing the original 
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message from the mix. This is called data encryption. The message to be encrypted is 

called the plain text document. After encryption using a particular order called algorithm 

or key, it is sent as cyphertext on the network. The recipient receives it and decrypts it 

using a reverse algorithm to the one used during encryption called a decryption key to get 

the original plain text document. Hence without the decryption key nobody can be able to 

reconstruct the initial message. Figure 6.1 is a flow diagram showing how a message can 

be encrypted and decrypted to enhance message security. 

 

6.5 Log files 

This is special system files that keep a record (1og) of events on the use of the computers 

and resources of the information system. This is because each user is assigned a user 

name and password or account. The information system administrator can therefore 

easily track who accessed the system, 'when and what they did on the system. This unto 

second information can help monitor and track people who are likely to violate system 

security policies. 

 

The most dangerous aspect in this case is when genuine users lose or give their 

passwords to unauthorized users. 

 

Firewalls 

A firewall is a device or software system t at filters the data and information exchanged 

between different networks by enforcing t e host networks access control policy. The 

main aim of a firewall is to monitor and control access to or from protected networks. 

People who do not have permission (remote requests) cannot access the network and 

those within cannot access firewall restricted sites outside the network. 

 

Laws governing protection of information 

Although most countries do not have laws that govern data and information handling, the 

awakening has started and the laws are being developed. The "right to privacy" is 

expected by all people. For example, the data protection law may have the following 

provisions: 

1. Data is not transferred to other countries without the owner's permission. 

2. Data and information should be kept secure against loss or exposure.  

3. Data and information should not be kept longer than necessary.  

4. Data and information should be accurate and up to date. 

5. Data and information be collected, used and kept for specified lawful purposes. 

 

Therefore, countries are encouraged to develop a data and information handling legal 

framework that will protect people's data and information. 


